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Welcome…
…and thank you for your purchase of the LAI-2200

Plant Canopy Analyzer. The LAI-2200 is the follow-up

to the LAI-2000, which LI-COR Biosciences produced

and sold for over 20 years. At LI-COR Biosciences, it is

our passion to provide scientific instruments of excep-

tional quality, and we hope that the LAI-2200 performs

exceptionally for you. We welcome your comments

and suggestions - feel free to contact us at any time.

About this Manual:
This manual should serve as a guide to understanding

the proper operation, abilities, and limitations of this

instrument. Operators who are new to the instrument

and its principles are encouraged to read all the theory

sections and to become acquainted with the body of

published literature that cites data collected with the

LAI- 2000. Operators who are familiar with the

LAI-2000 could skip over the theory, measurement

guidelines, and canopy type sections and jump right

into Chapters 3 and 8. The menu-level contents can

help you find explanations of the various functions

provided by the LAI-2200 instrument. Chapter 6 is a

guide for the FV2200 software, which provides a higher

level of post processing functionality.

Familiar with the LAI-2000? See Appendix F for a

brief comparison.
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1 Getting Started
About the LAI-2200
The LAI-2200 calculates Leaf Area Index (LAI) and

other canopy attributes from light measurements made

with a “fish-eye” optical sensor (148° field-of-view).

Measurements made above and below the canopy are

used to calculate canopy light interception at five

zenith angles, from which LAI is computed using a

model of radiative transfer in vegetative canopies.

What’s What

If you have just taken delivery of your LAI-2200 check

the packaging list and verify the contents of the ship-

ment. The following components should be included:

LAI-2270 Control Unit

The LAI-2270 Control Unit

(console) is used to configure

instrument settings, store

recorded data, and compute

results. The LAI-2270 is

shipped with 4 “AA” alkaline

batteries, which can provide

up to 140 hours of operation.

An internal lithium backup

battery maintains the clock when the main batteries are

removed. Refer to page 2-1 for a complete description.
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LAI-2250 Optical Sensor

The LAI-2250 Optical Sensor (wand) is the data col-

lection component of the LAI-2200. It is shipped with

two “AA” alkaline batteries, which can provide over 8

hours of continuous use in “autonomous mode”. A

protective cap is provided to cover the bulkhead con-

nector. Refer to pages 2-5 for a complete description.

The optical sensor contains high precision optical com-

ponents, including lenses, optical filters, and light

sensors. It should be treated like an expensive camera

lens and protected from impacts and intense vibration.

See the section on “Maintenance” (page 2-7) for com-

plete care instructions.

View Caps

Five view restricting caps (p/n 9920-005) are provided

with the LAI-2200. The solid cap (p/n 6520- 020)

should be used to protect the lens when it is not in

use. The five view restricting caps serve to limit the azi-

muthal field of view of the optical sensor in cir-

cumstances in which it is necessary or desirable to

block part of the view.
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Data Cables

A USB Type A to USB Type Mini-B cable (p/n 392-

07872) and a 9-pin female to female RS-232 cable (p/n

9975-016) are provided to transfer data between the

LAI-2200 and a computer.

Optical Sensor Cables

One 6-pin cable (p/n 9922-127) with bulkhead con-

nectors is provided with each optical sensor. It is to

connect the optical sensor to the control unit.

Bubble Levels

Two bubble levels are provided with each optical

sensor. One is a bottom level (p/n 610-03047) that

attaches to the underside of the optical sensor for use

in situations in which the sensor is held over the oper-

ator’s head. The top level (p/n 610-03048) attaches to

the top of the optical sensor.

Both levels look very similar, however, the top level has

the manufacturer’s name printed on the bottom,

whereas the bottom level does not. They can also be

distinguished from one another because it is nearly

impossible to stabilize the bubble inside the ring when

the level is inverted.

Lens Cleaning Kit

The Lens Cleaning Kit (p/n 610-03100) includes clean-

ing solution and lens cleaning cloth.

Carrying Carabiner

A carabiner (p/n 610-10456) is included to allow hands-

free transportation of the control unit. The clip
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attaches to the base of the control unit with a ring. It

can be attached to the user’s belt loop.

Calibration Sheet

The calibration sheet indicates the angular response of

your LAI-2250 and its response in an isotropic envir-

onment. It is a good idea to store the calibration sheet

in a safe location. If it is lost, contact LI-COR Bios-

ciences for the calibration information for your instru-

ment.

Software CD

The Software CD (p/n 618-

10669) contains the LAI-2200

software (FV2200), which is

compatible with computers

running Windows ® XP,

Vista, or 7; Mac® OS X; or

Linux operating systems. The

latest versions are available

from www.licor.com.

Instruction Manual

The Instruction Manual (p/n 984- 10633 ) contains

basic operating and maintenance information for the

LAI-2200.

Accessory Kits

Two accessory kits are provided, one for the control

unit (p/n 9922-107), and one for each optical sensor

(p/n 9922-108). They include frequently replaced com-

ponents, such as bulkhead connector end caps.
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Theory of Operation
Leaf Area Index is one- sided leaf surface area per

ground surface area. Because the LAI-2200 is sensitive

to all light-blocking objects in its view, the term foliage

area index is more appropriate. In scientific literature,

the terms effective Plant Area Index (PAIeff) (Garrigues

et al. 2008), Vegetation Area Index (VAI) (Fassnacht et

al. 1994), and others have been used to refer to indirect

LAI measurements that may include non-leafy veget-

ation. We use the term LAI throughout this manual,

except when discussing measurements of isolated

plants, in which case we use the term Foliage Density.

For more on this, see Computing LAI on page 6-34.

Basic Theory

The amount of foliage in a vegetative canopy can be

deduced from measurements of how quickly radiation

is attenuated as it passes through the canopy. By meas-

uring this attenuation at several angles from the zenith,

foliage orientation information can also be obtained.

The LAI-2200 measures the attenuation of diffuse sky

radiation at five zenith angles simultaneously. The LAI-

2250 Optical Sensor projects the image of its nearly

hemispheric view onto five detectors arranged in con-

centric rings.

Thus if the sensor is level and viewing the sky, detector

1 will measure the brightness straight overhead, while

detector 5 will measure the brightness of a ring

centered at the 68° zenith angle (22° above the hori-

zon), subtending 13°.

A normal measurement with the LAI-2200 consists of a

minimum of ten numbers: five of the numbers are the
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signals from the five detectors when the optical sensor

was above the vegetation, and the remaining five are

the readings made with the sensor below the veget-

ation. For both readings, the sensor is looking up at the

sky. Five values of canopy transmittance are calculated

from these readings by dividing corresponding pairs.

For example, if detector 1 reads 50 (units not import-

ant) above the canopy and 5 below, then the trans-

mittance at that angle (centered at 7°) is 5/50 = 0.10.

From transmittances at all five zenith angles, the LAI-

2200 calculates foliage amount (leaf area index, LAI)

and foliage orientation (mean foliage tilt angle, MTA).

In practice, anumber ofbelow-canopy readings are usu-

ally made to improve the spatial average.

Optical filter

Mirror

Lenses

Sensor

7°     23°    38°    53°    68°

Assumptions

There are some basic assumptions that must be met in

order to make accurate calculations of foliage density

and orientation. The extent to which these assump-

tions are violated will affect the accuracy of meas-

urements and subsequent calculations. The four major

assumptions, in approximate order of importance, are:

1. The foliage is black. It is assumed that below-can-

opy readings do not include any light that is reflec-

ted or transmitted by foliage. An optical filter in
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the LAI-2250 Optical Sensor rejects any radiation

>490 nm. Foliage typically reflects and transmits

little radiation in this portion of the spectrum,

which helps minimize violations of this assump-

tion.
2. The foliage is randomly distributed within certain

foliage- containing envelopes. These envelopes

might be parallel tubes (as in row crops), a single

ellipsoid (an isolated bush), an infinite box (turf

grass), or an infinite box with holes (deciduous

forest with gaps).
3. The foliage elements are small compared to the

area of view of each ring. The approximate

guideline is this: the distance between the sensor

and the nearest leaf above it should be at least four

times the width of the leaf. This relationship is

described in more detail later in the manual.
4. The foliage has random azimuthally orientations.

That is, it does not matter how the foliage is

inclined, as long as all the leaves are not facing in

the same compass direction. The importance of

this assumption is reduced when measurements

are made in a wide range of compass directions or

without a view-restricting cap.

No real plant canopy conforms exactly to these assump-

tions. Foliage is never random, but is often clumped

along stems and branches, and certainly is not black.

Many species exhibit heliotropism, which violates the

azimuthal randomness assumption. The practical com-

promises that must be made are often not serious, how-

ever. Many canopies can be considered random, and

living foliage does have relatively low transmittance and

reflectance of light below 490 nm. Offsetting errors

may be common, such as when leaves are grouped
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along stems (increasing light transmittance), but

arranged to minimize overlap (decreasing trans-

mittance).

Some canopies violate these assumptions to an extent

that requires consideration. Measurements of conifer

canopies, with their high degree of organization, or sen-

escent crops, with thin reflective leaves, might have

large absolute errors. The LAI-2200 is very sensitive to

small relative differences. In some cases, it might be

necessary to calibrate the instrument with direct meas-

urements in order to achieve high absolute accuracy.
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2 Introduction to the
Instrument

The purpose of this section is to describe the physical

characteristics of the instrument and to introduce the

keypad interface, basic software navigation, initial

setup, and instrument care.

LAI-2200
Plant Canopy Analyzer

OK

LOG

START

STOP

MENU EXIT

1 2 3

4 5 6

7 8 9

0. -

abc def

ghi jkl mno

pqrs tuv wxyz

X    Y
1            2

®

Light Sensor 

Connectors

LAI-2250 Optical 

Sensor Connectors

RS-232 Port USB Port

Control Unit
The control unit (console) hous-

ing is constructed from durable

ABS plastic with a rubber seal

between the two halves. The rub-

ber seal also serves as a shock

cushion to protect the instru-

ment from impacts.

Display

The display is a 128x64 LCD

graphics display. It displays alpha-

numeric characters. To adjust the

display contrast hold the minus(-)

key and press the up or down

arrow keys.

Keypad

The LAI-2200 features a 22- button tactile response

keypad. The upper block of 9 keys are used to navigate

through menus, select menu options, and log data.
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Basic functions of the upper 9 keys are described

below. The lower block of 12 keys are used to enter

alphanumeric characters. Each key is used to enter the

letters and numbers indicated by the label on the key.

MENU

EXIT

OK

START

STOP

LOG

Press the Menu button to go to the Main Menu; 

or when in Logging Mode, to go to the Log 

Adjust menu.

The Exit button returns to the main screen unless 

an input or toggle field is active. In these cases it 

returns to the previous screen. 

The OK button selects the highlighted menu field 

or implements a setting after changes have been 

made.

The Right arrow and Left arrow buttons 

advance to the next or previous menu sub-level 

when on a menu screen. If  a toggle field is active 

they toggle the setting. They also are space and 

backspace keys in alphanumeric fields.

The Start/Stop button is used to initiate or 

terminate a logging sequence.

When in Log mode, the Log button records a 

reading (or two if  two wands are attached). 

The Up arrow and Down arrow buttons are 

used to navigate through menu options and 

increment or decrement values in some fields.
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When entering alphanumeric characters with the

keypad, each button cycles through a loop of char-

acters and stops looping when a different button is

pressed or after 1 second has passed without a button

press. Some fields can only accept numeric or alpha-

betic characters. The right arrow key is used to enter

spaces and the left arrow key functions as a backspace

key in alphanumeric fields.

Cable Connections

Cable connections are on the top and bottom of the

LAI-2200 console.

Optical Sensor Cable Connections

The 6-pin bulkhead connectors (labeled X and Y) are

to attach optical sensors (wands). The control unit will

automatically detect an attached wand. Wands can be

attached or removed while the instrument is powered

on.

Light Sensor Cable Connections

Two BNC bulkhead connectors are available to attach

LI-COR Light Sensors. They are labeled “1” and “2”

on the front of the control unit and identified as Port 1

and Port 2 by the control unit.

LAI-2250 Optical Sensor (wand) connectors X & Y

BNC Light Sensor connectors 1 & 2
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Data Cable Connections

An RS-232 port and a Mini USB port are available for

communicating with a computer (see page 6-3). When

connected with a USB cable, the computer will identify

the LAI-2250 as a mass storage device.

Mini USB and RS-232 ports

Memory

The control unit is equipped with 128 MB of non-volat-

ile flash memory. The instrument stores data on an

internal Secure Digital (SD) card, which should provide

sufficient memory for intensive data collection

(enough storage for over 1.5 million records).

The format for the SD card is FAT16. Do not modify

the card in any way when connected to a computer,

and never remove or replace the card unless it is with a

card purchased from LI-COR Biosciences (p/n 616-

10387). If you need to use a user-supplied SD card for

any reason, contact LI-COR for formatting instruc-

tions.
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Optical Sensor
The optical sensor (wand) is constructed with a durable

aluminum enclosure, which protects the electronic and

optical components. It can be mounted to a camera tri-

pod or raising pole using one of the ¼”- 20 tripod

mounting holes. It can be used independently of the

control unit for data collection. When the wand is

attached to a console, it is powered with the console

batteries – it does not require its own batteries. Other-

wise, it requires two “AA” batteries.

Keypad

The optical sensor keypad includes two buttons that

are used to log data, switch between A and B readings,

and power on/off the optical sensor. The LOG button

on the wand is the same as the log button on the con-

sole – if the console is in logging mode (see page 3-13),

the Log button will log a record to the open file.

A/B

POWER

ABOVE

LOG

LOG

On/Off Indicator

Logging Indicator

Above/Below 

Indicator

Toggle Above/Below; 

Optical Sensor 

Power Button

Log Button
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Optical sensors will turn on when 1) the control unit is

turned on (if the wand and control unit are attached),

or 2) the optical sensor cable is connected to a

powered-on control unit 3) the optical sensor power

button is pressed (when disconnected from the con-

trol unit). To turn the optical sensor off, press and hold

the A/B|Power button for 2 seconds. To switch

between A and B readings press and release the

A/B|Power button.

Indicator LEDs

Three LEDs indicate the state of the optical sensor.

The “Power” LED is illuminated when the sensor is

turned on. The “Log” LED illuminates when data is

being recorded. When the Log button is pressed the

log LED lights up for the duration of the reading and

turns off when the log is complete. The optical

sensor’s Log LED will flash every 2.5 seconds or 1

second as part of automatic, unattached logging (see

page 3- 16 ). The LED labeled “Above” indicates

whether the next reading from this sensor will be

labeled A (LED is on) or B (LED is off). Pressing the

A/B key switches between A and B readings.

Features

The optical sensor has 1 MB non-volatile flash memory

that is used when operated in unattached mode (for

about 25,000 records). The optical sensor will indicate

that its memory is full by flashing all three LEDs sim-

ultaneously. When the optical sensor batteries are low

(2 V), the green power LED will turn red. The optical

sensor will shut off automatically when the battery

voltage is below 1.8 V.
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Optical sensors do not require batteries when it is used

in attached mode - they use power from the control

unit. Be aware, however, that if a data cable is removed

during a data transfer between the wand and console,

the files may be damaged or lost. The control unit dis-

play indicates when data transfer is taking place with an

on-screen indicator (see Logging Mode, page 3-13). Be

sure to wait until data transfer is complete before dis-

connecting the data cable.

Maintenance
The LAI-2200 is designed for low maintenance, and

generally it should require little servicing beyond keep-

ing it clean and taking care of the batteries.
A

A
 B

a
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A
A
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Proper polarity for 

LAI-2250 Optical 

Sensor batteries

Control Unit

The control unit battery compartment

is on the back of the instrument. To

open the battery compartment, remove

the two screws that secure the battery

cover with a #1 Philips screwdriver.

The control unit requires 4 “AA” bat-

teries. Be sure to observe proper polar-

ity when changing batteries. Replace

the batteries and reattach the cover.

Optical Sensor

The optical sensor uses 2 “AA” bat-

teries, which are in the handle of the

optical sensor. To remove the optical

sensor batteries, use a coin or large flat-

tipped screwdriver to turn the battery

cap counter clockwise about ¼ turn.

2
In
tro

du
ct
io
n
to

th
e
In
st
ru
m
en
t



LAI-2200 InstructionManual

2-8

When inserting new batteries, insert the negative (-)

pole into the battery holder first. The positive (+) pole

on the second battery makes contact with the black cap

(p/n 345-10735).

If the instrument is to be stored for a long period of

time, remove the batteries to prevent damage that may

result from battery leakage and corrosion.

Calibration

There are two parts to the factory calibration. One is

done at a range of angles in collimated light, and is used

to center the detector and verify the angular response.

The other is done in isotropic conditions (an integ-

rating sphere) and provides calibration factors that are

used to match each ring’s output to each other, but not

to any absolute standard. This inter-ring calibration has

no effect on LAI determination, but would be import-

ant if you were to use the sensor to map angular dis-

tributions of diffuse radiation.

Recalibration of the optical sensor is not necessary, as

long as the optics within the sensor remain in place.

The detectors may have long-term electrical drift, but

this will not affect LAI determinations.

Instructions for entering calibration multipliers are on

page 3-4. The procedure for matching two sensors is

separate from calibration and is described on page 3-10.

Cleaning

The optical sensor lens should be kept free of dust,

dirt, and deposits when collecting data. To help keep

the lens clean, leave the opaque lens cap in place when

the instrument is not in use.
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The front lens of the optical sensor can be cleaned

with distilled water or the Lens Cleaning Kit that is

included with the instrument.

Note: Be very careful not to scratch the MgF2 coating on the lens.

Avoid cleaning the lens with paper products, and never wipe the

lens while it is dry. Damage to the lens is not covered under the

warranty.

The instrument display and keypads can be cleaned

with a moistened non-abrasive cloth when necessary.

Storage

When storing the LAI-2200 for a long period of time,

remove the “AA” batteries, replace the bulkhead con-

nector caps, and put on the lens cap.
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3 Using the LAI-2200
This section introduces the basics of the LAI-2200,

including a description of configuration options, usage

considerations, and a guide for making basic meas-

urements. It is recommended that users who are unfa-

miliar with the LAI-2200 follow the example

measurements and become thoroughly acquainted

with the practical considerations (in the next two

chapters) before attempting real measurements with

the LAI-2200.

Initial Setup
Power ON and OFF

To power on the LAI-2270 Control Unit press the

power button. It is below the left side of the display.

If it is not attached already, attach an optical sensor to

the X or Y port using the cable (p/n 9922-127). The

optical sensor should turn on when the control unit is

turned on (if the cable is attached), when connected to

a powered up control unit, or when the optical sensor

power button is pressed.

To turn off the control unit, press the power button.

To turn off the optical sensor, press and hold the

power button for 2 seconds. The control unit features

a user-settable auto off timer that will shut off the

instrument automatically. The auto off timer can be set

for 5- 60 minutes. The optical sensor automatically

shuts off in 30 minutes if no button is pressed (unless
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configured for automatic logging orconnected to a con-

trol unit).

Console Auto-off Timer

To set the auto-off timer on the Control Unit (con-

sole), press the Menu button, select Console Setup,

then Auto-off Timer . Set the timer as desired and

pressOK to save the settings.

Monitor Mode Navigation

X1: 634.0710

X2: 727.1623

Y1: 0.0000

Y2: 0.0000

When the LAI- 2200 is

turned on, Monitor Mode

(right) will be displayed.

Observe the variables

called X1, X2, Y1, and Y2.

These are values from rings

1 and 2 from the X and Y sensors. Each row of Mon-

itor Mode can be set to display any one of the values in

Table 3-1.

Table 3-1. Variables that can be displayed inMonitor Mode.

X1,...,X5   Readings for Wand X, rings 1 - 5

Y1,...,Y5   Readings for Wand Y, rings 1 - 5

T:       Time (HH:MM:SS)

D:       Date (YYYY/MM/DD)

BATT:       Battery voltage

1:       Readings for Light Sensor 1

2:       Readings for Light Sensor 2
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X1: 634.0710  

X2: 727.1623

Batt: 5.80

T: 03:24:48

To change variables on the

display, press the up or

down arrow to select a field.

The active field will be high-

lighted for about 1 second.

Press the right or left arrow

button to scroll through available variables.

Basic Menu Navigation

Main Menu
 Wand Setup
 Log Setup
 Data
 Console Setup
 Firmware

Basic navigation through

menus is accomplished

with the upper block of 9

keys. When viewing a

menu (press theMenu but-

ton to view the Main

Menu, shown below), the selected menu level will be

highlighted. Press OK or the Right Arrow to select

the highlighted menu option, press the Left Arrow key

to go back a menu level or toggle field settings, and

press EXIT once to return to the Main Menu or twice

to return to Monitor Mode.

Setting the Clock

Be sure to set the clock on both the console and

optical sensor(s).

Console

The console clock uses 24-hour time notation (1:00

p.m. = 13:00). To set the clock:

1. Press the Menu > Console Setup > Set Time

and pressOK (or the Right arrow button).
2. The time field reads HH:MM YYYY/MM/DD.

Use the Up and Down arrow buttons to select the
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correct values for each field, and use the Left and

Right arrow buttons to switch between fields.
3. PressOK to implement the new time orEXIT to

abandon changes.

Optical Sensor

The optical sensor (wand) clock can be set manually or

synchronized with the control unit clock.

1. To set the wand clock, connect the wand to the

control unit, go to the Menu > Wand Setup >

Select wand > Clock and pressOK (or the Right

arrow button).
2. Select Set Time to set the clock manually or Sync

Time to synchronize the optical sensor clock with

the control unit clock.
3. The time is implemented after you select “Yes”.

Verify the time and pressOK.

Note: If using two optical sensors, the clocks in both must be syn-

chronized in order to match data in time. Be sure to synchronize

the clocks.

Calibration and Match Values

Every wand has two sets of 5-number calibration val-

ues: The “permanent” set (accessible via Menu >

Wand Setup > Cal Values ) and the “working” set

(Menu > Wand Setup > Match Values). The match

values are the ones that are always used when the wand

is making measurements. The only reason the cal val-

ues (which are printed on each wand’s calibration

sheet) are there is to serve as built-in reset values,

whenever you choose to do that.

Normally, the match values aren’t important – as long

as none of them are 0, which would make the
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corresponding ring read 0 all the time. When they are

important is when two wands are in use, and when

both wands will ultimately contribute to the same LAI

file. In that case, one of the wands will need to have its

match values changed so the pair will make the same

measurement under the same conditions This simple

procedure is described on page 3-10.

Overview of Configurations
Basic Setup

The settings described below in “Wand Setup” affect

the selected wand and are stored on the wand. Those

described in “Log Setup” affect the global template

and will be applied to any new file that is created on the

control unit. Settings that affect how LAI is computed

are stored as part of each file. The procedure for chan-

ging the settings of a file (post processing data) is

described on page 3-25 (control units) and in Chapter 6

Data Analysis with FV2200 (using FV2200).

Wand Setup

Certain pieces of information are stored on each optical

sensor. You may wish to change or view these settings.

They are described below. In order to access these set-

tings, one or more wands must be connected, and you

must select a wand.

Set Name: You can name each wand (up to 8 alpha-

numeric characters). The name is stored on the wand

and can be viewed when the wand is connected to a

console.
Clock: Set the wand time by synchronizing with the

console clock or entering the time manually.
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Cal Values: View/Edit the 5 back-up calibration val-

ues. These values are shown on the wand’s cal-

ibration sheet.
Match Values:Access the 5 working cal values: view/-

set values to directly edit or reset them, and cal-

culate values for matching two wands.
Auto Log: The control panel for setting up automatic

logging for wand.

Log Setup

Basic parameters can be set prior to collecting data. For

most applications the default settings will work fine,

but the preferred settings will vary depending on the

application. Most of the following settings can be

changed for a file after data has been collected as well.

The following items are in theMain Menu > Log

Setupmenu:

Transcomp: Defines how transmittance is computed

(including which readings (A or B ) are used for

above-canopy readings, how they are used, and what

the instrument does with transmittances >1.0).

These settings are described in detail in the table

below. Normally, A readings are above canopy, and

B readings are below. The software can also be set to

determine which is above and which is below by

comparing the readings (ring by ring) of successive

A/B pairs or records until it finds a pair for which

every ring of one is consistently higher than the cor-

responding ring of the other. The ID of the higher

record, whether A orB , is assumed to be the above

record ID through the rest of the file.
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Transcomp Description

Setting 

Define Above

A (Default) A records are Above, B are Below

B B records are Above, A are Below

Compare Find which is Above and which is Below

Determine Above

Previous (Default) Use the previous Above record

Interpolate Interpolate between the nearest (time) Above readings

Closest Use the closest in time Above record

Bad Readings (when a Below record has values that exceed those of a 

corresponding Above record)

Skip (Default) Skip that record

Clip Force the transmittance (Below/Above) to be 1.0 for

 that ring

Prompts: Two prompts can be defined, and responses

can be entered during data collection (see page 3-12

for details) for each file.
Obs Remarks: An observation remark can be entered

for each data record. This remark is edited in the log

setup menu, and can be changed for individual

records by pressing the Menu key while in Logging

Mode.
Angles: This provides access to the angle values asso-

ciated with each ring. There is no need to change

these values.
Distances: The distance vector consists of five values

used in calculation of contact numbers for the five

rings of the optical sensor. Use the default values

unless you are measuring an isolated crown of a

plant. Refer to page 5-13 for more information.
Masks: The mask determines which rings are used

(default = all) to compute LAI. Data from rings that

are ignored are still measured and recorded, how-

ever, so nothing is lost even if a data file is generated

with all rings ignored.
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Controlled Sequence:A sequence of A and B readings

can be defined, then the instrument will prompt you

for the next reading.
PAR Sensors: Activate, name, and enter the cal-

ibration multipliers for LI-COR Biosciences Light

Sensors here.

Console Setup

The Console Setup menu (Main Menu > Console

Setup) provides some basic setup options:

Set Time: Set the instrument time, as described on

page 3-3.
Auto Off Timer: Set the duration that the control unit

will remain powered on after no buttons have been

pressed (5-60 minutes, increments of 5 minutes).
Beeper: Turns the console beeper on or off.



3 Using the LAI-2200 

3-9

Attached vs. Autonomous Con-

figuration

Attached Configuration

This is the configuration used when the optical sensor

(s) is attached to the control unit. The main advantage

of having the sensor attached to the console is real-

time display of measured or computed values. When in

log mode, pressing the wand or console LOG button

adds data to the file on the console, not the wand, and

LAI calculations are updated for that file.

Autonomous Configuration

This is useful for logging above canopy readings well

away from the console, for later import to the console.

Data can be logged manually (press LOG) or auto-

matically (page 3-16) on an unattached wand, and later

transferred to the console and merged with below-can-

opy readings. Note that you can also use a wand by

itself to make complete one-sensor readings of a can-

opy: Just label above and below readings appropriately

using the A/B button, transfer the result to a file, and

recompute that file.  However, since records stored on

a wand accumulate in one big file, this method is not

convenient for generating multiple LAI files, unless

you keep careful track of starting and stopping times,

so you'd know how to parse the file later.
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Operating Modes: One and Two

Sensor Modes

One Sensor Mode

The simplest operating mode is to use one sensor for

above and below readings. A sequence of readings can

be predefined (see controlled sequence, page 3-15 if

attached to a console), or determined “on-the-fly” by

using the A/B key on the wand keypad. The basic pro-

cedure for using this mode is described on page 3-20.

Two Sensors Mode

Two-sensor mode simply means that there are two (or

more!) sensors involved in collecting above and below

canopy readings. Both sensors can be attached to the

console during the measurement, but they don't have

to be. If both aren't attached you'll have to do some

work later to get the files together (page 3-23). Either

way, you'll have to do some work up front or after the

fact to make sure all sensors involved are matched – so

they read the same things under the same conditions.

This is described in the next paragraph.

Matching Sensors

There are two approaches to matching sensors. One

method, described here, matches the sensors before

data is taken. Thus, you do a little up-front work, and

then don't worry about it. The other approach is to not

bother about getting the sensors to agree at the start,

but rather simply make a reading or two with both

sensors having the same view. You might do this

before taking data, then again at the end. These read-

ings are then used in post-processing to adjust the data
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from one of the sensors before LAI is recomputed. See

page 6-14 for a detailed description.

Here’s how to make two sensors match each other

before collecting data. It will adjust the match values of

one sensor.

1. Attach the two sensors to be matched to the con-

sole, and turn on the control unit.
2. Place the sensors side by side so they both see the

exact same diffuse view (no direct sun). View the

readings in Monitor Mode (page 3-2).
3. Set match values.

a. PressMenu, select Wand Setup, select a wand

and pressOK.
b. SelectMatch Values and pressOK.
c. Select Calculate and press OK . The wand

chosen in step “a” will be set to match the

other wand. PressOK.

4. View values in Monitor Mode to confirm match.
5. To reset the original calibration values, select

View/Set Values from theMatch Values menu

(Menu>Wand Setup>select wand>Match Val-

ues). Press “Log” to reset, then OK.

Note that when data is logged, each A or B record con-

tains an indicator (e.g. W1, W2, etc) telling what wand

took the data. In the header is a “Contributing Sensors”

section that relates the wand indicators to actual serial

numbers and match values:
 :

DISTS 1.008 1.087 1.270 1.662 2.670

GAPS 0.000 0.000 0.000 0.000 0.000

### Contributing Sensors

MATCH W1 PCH2516 3978 1244 1000 1004 1289

MATCH W2 PCH2462 3650 1044 900 904 1144

### Data

A 1 20090924 15:23:21 W1 199.228 198.956 202.214 186.611 190.670

B 2 20090924 15:23:55 W2 2.48003 2.33006 2.68008 3.11003 4.21009

B 3 20090924 15:24:02 W2 7.43006 2.60031 2.15000 3.34005 4.14001

 :
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Set Prompts

There are two prompts for storing additional inform-

ation with each data file. Each prompt can be defined

so that it requests a specific type of information, such

as “What” and “Where”. In this case, for the “What”

prompt, you could enter a habitat type, and for the

“Where” prompt, you could enter the location. After

they are defined, you can enter up to 8 alphanumeric

characters in each of the prompt fields when you create

a new data file. To set prompts:

1. Press theMenu button, then go to Log Setup and

select Prompts.
2. Enter the desired prompts in the Prompt1 and

Prompt2 fields. If you wish, you can enter default

responses, or leave the Resp1 and Resp2 fields

blank. Either way, you will be able to enter

responses in the Resp1 and Resp2 fields when you

create a new data file.

Creating Data Files

An LAI measurement is made by collecting above and

below readings in a file. Follow the steps below to cre-

ate a new file:

1. With the instrument on, press the START|STOP

button.
2. Select “New File” and enter a file name (a max-

imum of 8 characters or numbers). File names are

automatically generated based on the previous

entry, incremented by one digit.
3. View/Edit remarks, and/or pressOK.
4. The LAI-2200 is now in Logging Mode (below).

Log A and B readings.
5. Press Start|Stop (orExit) to save the file and quit.
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Logging Mode

After a new file is created (see above), the console will

enter Logging Mode, which is used to log data to the

open file. In Logging Mode, the display will show four

lines of data. The Status indicator line is always dis-

played, along with three of the following fields:

A:# B:#  # A readings, #B readings

T:        Time (HH:MM:SS)

D:        Date (YYYY/MM/DD)

BATT:      Battery voltage

1 or 2  Readings for Light Sensor 1 or 2

X1,...,X5 Readings for Wand X, rings 1 - 5

Y1,...,Y5 Readings for Wand Y, rings 1 - 5

SEQ:  Off or ...AB...to indicate controlled sequence

LAI:  Current Leaf Area Index

SEL:  Standard Error LAI

MTA:  Mean Tilt Angle

SEM:  Standard Error MTA

Use the arrow keys to change what is displayed in the

other fields. These changes are saved automatically.

READY  X:A Y:-

A: 0 B: 0

LAI: 0.00

SEL: 0.00

Status Indicator: 

READY when waiting 

for data, WAIT when 

processing data.

Optical Sensor Status: indicates 

which sensors are connected 

and whether the sensor is set for 

an Above or Below reading. 

Here, a wand is connected to  

the X terminal and it is set to log 

an Above reading.

# of A readings

# of B readings

Leaf Area Index 

calculated from the 

current data.

Standard Error of LAI.
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You can also enter the “Log Setup” menu from the log-

ging menu (press the Menu key while in Logging

Mode). Any changes made here will only be reflected

in the current file, except changes to light sensors,

which will be retained even after exiting Logging

Mode.

Computations During Logging

While logging data, the LAI-2200 provides real time

updates of some computed quantities, such as LAI.

These computations are always done with a

TransComp setting of “xPx”. That is, the middle setting

(Determine Above: Previous, Interpolate, or Closest in

time) is always P (Previous), regardless of what you

have selected. This is out of necessity, because there is

no way to interpolate or choose the closest “Above”

reading before all the “Above” readings have been

made. When you are done logging and close the file, if

the file needs to be recomputed because of this mis-

match, (or for other reasons, such as logging to an exist-

ing file), you will be prompted with “Recompute?”. If

you respond with “OK”, the file is recomputed and

stored. If you decline the recomputation, the file is

stored without being recomputed. It can be recom-

puted at a later time.

Logging Configurations

Manual Sequence

This is the simplest way to collect data with the LAI-

2200. The optical sensor can be attached (a file must be

open to use attached mode) or detached from the con-

trol unit. Select “Above” or “Below” with the

A/B|Power button, position the sensor and press
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“Log” to record data values. Each record will be tagged

with an A or B, depending on settings. To collect data

in this mode, go toMenu > Log Setup > Controlled

Sequence > Use = No, create a new file (page 3-12),

enter Logging Mode (page 3-13), and begin recording

data. Or, disconnect the wand from the console and

simply begin recording data. Manually controlling the

sequence is an option whether the wand is attached to

a console or not.

Controlled Sequence

If a wand is attached, then a controlled sequence is an

option. Specify beforehand what sequence you want,

(for example, ABBBB with 3 repetitions), and the con-

sole will automatically label logged records accordingly.

The Above LED on the wand (and the SEQ lines on

the console) will indicate the next required reading.

The following steps describe how to define a

sequence:

1. Connect the optical sensor to the control unit.
2. Go toMain Menu > Log Setup > Controlled

Sequence and pressOK.
3. Set the “Use” field to “Yes”.
4. Set the number of repetitions (from 1 to 41).
5. Define the sequence. Press the number 2 button to

specify an A reading and the 8 button to specify a

B reading (e.g. for the sequence ABBBB , press

28888). The sequence can have up to 20 readings.
6. Press OK . The controlled sequence will be used

for any new file.
7. Create a new file. To view your position in the

sequence, in the logging screen, use the left or

right arrow key to change a field to indicate “Seq:”.

This will indicate where you are in the sequence.
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The wand LEDs indicate which reading is next in

the sequence.

The sequence can be interrupted at any time by press-

ing the A/B|Power button. Forexample, if the upcom-

ing measurement is specified as an A reading, press the

A/B|Power button to change the upcoming reading

as a B reading. After logging the data point, the

sequence will continue with the next specified meas-

urement.

To deactivate the controlled sequence, set the “Use”

field to “No”.

Automatic Logging

This configuration option allows you to set up an

optical sensor to log data at specified intervals, whether

or not the wand is attached to a console . Automatic logging

can be configured to record data values at intervals

from 5 seconds to 3600 seconds (60 minutes) in 5

second intervals. You can also specify the start and end

time and date for automatic logging. Automatically

logged data can be treated as A or B readings. Data

points can be manually logged during auto-logging by

pressing the Log button.

The following procedure describes how to configure

automatic logging:

1. From the Main Menu, selectWand Setup, select a

wand, and press OK . Then select Auto Log and

pressOK.
2. Select Start Time, and enter the desired start time

and day (you can only set the start day of the cur-

rent month). PressOK.
3. Select Stop Time, and enter the desired stop time

and day (current month). PressOK.
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4. Select Frequency and enter a multiple of 5 seconds

between 5 and 3600 seconds. Press OK after enter-

ing the value.
5. Select the On/Off field, highlight “On” and press

OK. The optical sensor can be disconnected from

the control unit. If the wand is powered off, it

should power up automatically at the specified start

time. If these readings are “Above”, be sure that

the blue “Above” LED is illuminated. This will

ensure that these readings are tagged with an “A” in

the file.

When automatic logging is “On”, the Log LED on the

wand will blink every 2.5 seconds during the run-up to

the logging start time. When it begins logging data, the

LED will blink every second and the wand will beep at

the beginning and end of each log.

Transferring Wand Data

Data is stored in a wand under these conditions:

l Data logged because of automatic logging (attached

or unattached)
l Log button pressed while wand unattached.

Wand data can be moved to the console, put in a new

file, or appended to an existing file. Here are the steps:

1. Connect the wand to the console. From theMain

Menu, select Data.
2. SelectWand Data and then choose Download.
3. Select the optical sensor that has the desired data.
4. Choose “New File” to create a new data file or

choose “Add to File” to append an existing data

file.
5. If you choose “New File” name the file (up to

eight characters) and press OK . If you choose
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“Add to File”, select the file from the list and press

OK.

It may take several seconds for the file to be transferred

and for appended files to be modified. When the file is

copied, it remains in the memory of the optical sensor.

To delete files from the optical sensor memory, select

“Purge” from the Wand Data menu, and then select

the appropriate optical sensor. Press OK to purge, or

EXIT to return to theWand Datamenu.

Connecting PAR Sensors

The light sensor connectors (1 and 2) on the LAI-2200

accept LI-COR Biosciences Quantum sensors (LI-190

or LI- 191), Pyranometers (LI- 200), or Photometric

sensors (LI- 210). In most applications, Pho-

tosynthetically Active Radiation (PAR) is the variable of

interest. The light sensor connectors are configured to

measure the signal (microamps) normally provided by

LI-COR Biosciences light sensors.

Follow this procedure to enable a light sensor:

1. Attach the light sensor cable to port 1 or 2, then go

to Menu > Log Setup > PAR Sensors , select

Port 1 or Port 2 (whichever has a light sensor

attached), and pressOK.
2. Set the “Enabled” field to “On”.
3. (Optional) Name the sensor. The name is used in

the “Contributing Sensors” section of data files

(see page 3-29).
4. In the “Cal” field, enter the calibration multiplier

for your light sensor. The calibration multiplier is

printed on your sensor’s calibration sheet. It also

can be found on LI-COR Biosciences’ Technical
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Resources Library web site.
5. PressOK to implement the changes.

Light sensor settings are saved to the global template

and will be applied to any data file that is created.
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Making Basic Measurements
Making measurements: Now that you’ve become famil-

iar with the operating principles of the LAI-2200 and

the instrument accessories, it is a good idea to make a

few sample measurements. Be sure to review the “prac-

tical considerations” in Chapters 4 Measurement

Guidelines and 5 Canopy Types prior to collecting

actual data because the use of improper measurement

techniques will result in poor data quality.

Operation: One Sensor, One Con-

trol Unit

This step-by-step section requires one LAI-2270 Con-

trol Unit and one LAI-2250 Optical Sensor and view

caps. You will be guided through the following pro-

cedures:

l Create a data file
l Make a measurement
l View live readings in Logging Mode

1. Place the desired view cap (see chapters 4 Meas-

urement Guidelines and 5 Canopy Types) on the

sensor with the opening pointing away from the

handle. Attach the optical sensor to the control

unit (either the X or Y terminal) and turn on the

control unit. Verify that the sensor is operating cor-

rectly by placing a hand over the lens and observing

that the reading drops (in Monitor Mode). Remove

your hand and notice that the reading returns to

normal.
2. Set prompts, if desired (see page 3-12).
3. Press the START|STOP button on the control

unit and choose New File. Enter a file name.
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4. Enter responses to the prompts and press OK to

save or Exit to skip the prompts. Now the LAI-

2200 will enter Logging Mode and it is ready to

record data.
5. Position the optical sensor above the canopy. Be

sure it is level and that no foreign objects are in

view of the sensor. Verify that the Above LED is

illuminated (press the A/B button on the wand if it

is not). Press the Log button on the wand or con-

trol unit to record an Above reading.
6. Press the A/B button (the Above LED will turn

off). Hold the optical sensor below the canopy

(level and oriented in the same direction as the

above-canopy reading was) and press the Log but-

ton to record aBelow reading.
7. LAI, MTA, SEL, and SEM values will be visible in

Logging Mode (use the arrow keys to change what

is displayed).
8. Continue making B readings, moving the sensor to

a new location each time. Typically, the distance

between B readings is on the order of the canopy

height. You can intersperse A readings as neces-

sary, if sky conditions or the view direction

changes.
9. When you are finished, press the START|STOP

button to close the file and exit Logging Mode.

Operation: Two Sensors, One Con-

trol Unit

The steps in this section require one control unit and

two optical sensors. In this section and the section that

follows, you will be guided through the following pro-

cedures:
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l Match the sensor
l Set up data logging with one sensor in autonomous

mode and the other in manual mode
l Create a data file
l Make measurements
l Merge the two datasets on the control unit
l View data on the control unit

1. Synchronize the clocks in both wands (see page 3-

3), and purge any data from the wand that will log

the Above readings (Menu > Data > Wand >

Purge).
2. Place the desired view caps over the lenses of two

optical sensors with the openings facing away from

the handles (see chapters 4 Measurement

Guidelines and 5 Canopy Types ). Connect the

optical sensors to the control unit and turn on the

control unit.
3. Match the sensors as described on page 3-10.
4. Set prompts if desired.
5. Match the sensors. SelectMenu > Wand Setup >

select wand > Calculate Values. Choose how to

match the wands. Be sure that both wands have the

same view cap, are level, and share exactly the same

view. Press OK. The instrument will compute new

match values for one of the sensors.
6. Navigate toMenu > Wand Setup >select the

wand that will record Above readings >Auto

Log.
a. Set Auto Log to “On” and pressOK.
b. Set the Start Time/Date as desired (remember

to use 24 hour notation) and pressOK.
c. Set the End Time/Date to 30 minutes past the

current time/day (or as desired) and pressOK.
d. Set the Frequency to 60 seconds and pressOK.
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The Log LED will blink every 2.5 seconds prior to

the start time.
7. Disconnect the sensor that was configured in the

previous step. Place it in an area that affords a clear

view of the sky. Be sure it is level, stable, and ori-

ented so it views the same sky that the below-can-

opy sensor will see.
8. Press the START|STOP button on the control

unit, selectNew File, and name the file.
9. Begin to record the below-canopy readings with

the other optical sensor and control unit. Always

be sure to orient the sensor so it is viewing the

same sky as the above-canopy sensor. Be sure that

all readings are tagged with a B (the blue “Above”

LED should be off when readings are taken).
10. After collecting the below-canopy readings, re-con-

nect the A readings wand to the control unit. If

autologging is still active on the A readings wand,

turn it off (Menu > Wand Setup > select wand >

Auto Log > Use = off).
11. Navigate to Main Menu > Data > Wand >

Download > select wand . Choose “Create new

file” and name the file. The records will be saved.

Purge the wand data if desired.
12. Follow the steps below to merge the two files and

compute LAI.

Importing A Readings from Separ-

ate Files (Console)

When A readings are collected autonomously, they

need to be imported by the file that holds the B read-

ings before LAI can be computed. This can be done

on the control unit (described below) or with the

FV2200 software see (page 6-14).
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1. If it hasn’t been done already, transfer the records

from the wand to the console: Navigate toMenu >

Data > Wand > Download > select wand .

Choose “Create new file” and name the file.
2. Navigate to Menu > Data > Consoleand select

the file that is to receive the imported records.

Select the file that has the B readings.
3. Select Edit from the menu, then select Import

Observations.
4. Choose to import A records.
5. PressOK and the file will be recomputed using the

imported records.
6. LAI values will recompute automatically and can be

viewed in Menu > Data > Console > select file

> View Header.

Data Management on the Console

File Quick View

To view a summary of a file, navigate to Menu > Data

> Console > select data file > Quick View. The file

header is presented:

Quick View:

File Name – The name of the file

Date and Time – Date file was created

Response1 and 2 – Responses to prompts 1 and 2

LAI – Leaf Area Index for the file

SEL – Standard Error LAI

ACF – Apparent Clumping Factor

MTA – Mean Tilt Angle

SEM – Standard Error MTA

DIFN – Diffuse Non-interceptance

SMP – Sample Size
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Viewing Data on the Console

To view data in a file, navigate toMenu > Data > Con-

sole > select data file > View. The following options

are presented:

View Header:

File Name – The name of the file

Date and Time – Date file was created

Response1 and 2 – Responses to prompts 1 and 2

LAI – Leaf Area Index for the file

SEL – Standard Error LAI

ACF – Apparent Clumping Factor

DIFN – Diffuse Non-interceptance

MTA – Mean Tilt Angle

SEM – Standard Error MTA

SMP – Sample Size
View ANGLES/MASKS:

Displays angles and masks used for each ring.
View CNTCT#/STDDEV:

Displays contact number and Standard Deviation for

each ring in the current file.
View AVGTRANS/GAPS:

Shows average transmittance and gap fraction for the

current file.
View Observations:

Shows values for individual readings. Use the left and

right arrow keys to navigate through the list.

Reprocessing Data on the Console

A set of basic data processing features are available on

the LAI-2200 Control Unit. Refer to Chapter 6 Data

Analysis with FV2200 for advanced data processing

with the FV2200 software. To edit data that is stored on
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the control unit, navigate to Main Menu > Data >

Console > select data file >Edit:

Edit Angles to change the angles (normally, the

default values should be used).
Edit Mask to apply a mask to one or more rings.

Masked rings are ignored when LAI is computed.

The data for masked rings is retained in the file.
Edit Distances to change the default distances. This is

useful for measuring isolated canopies (see page 7-3

for an example).
Edit Transcomp to change how transmittance is com-

puted. See page 3-6 for a detailed explanation.
Import Observations to import A records from

another file to the current file. This command

imports all A records or just the ones that are closest

in time to the existing B records in the target file.
Strip Observations to delete all A or B observations

from a file.

Additional Data Management Features

Three data management options, in addition to those

mentioned above, are available underMenu > Data >

Console Data > select data file. These include:

Recompute to recalculate LAI and other variables.
Delete to permanently remove the selected file.
Rename to rename the file.

Connecting to a Computer

The LAI-2200 has both an RS-232 port and USB con-

nection that can be used to transfer data to a computer.

Use of the USB port is described below. Refer to page

6-3 for instructions on using the RS-232 port using the

FV2200 application. Serial communication with RS-232
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should not be done while connected via USB. To transfer files

from the older LAI-2000 using FV2200, see page 6-5.

Plug the USB cable into a USB port on your computer

and the LAI-2270 Control Unit. The LAI-2200 is recog-

nized as a USB mass storage device when it is attached

to a computer (PC, Mac, Linux platforms are sup-

ported). The LAI-2270 will not be recognized if it is in Logging

Mode or a menu, so be sure to enter the Monitor Mode by pressing

EXIT, or just turn off the control unit.

When it appears on your desktop, the name of the

LAI-2200 will be LAI unless it has been renamed.

Inside the LAI directory, you will find a folder named

Data, and inside Data you will find your logged data

files.

These files can be manipulated in the normal ways: you

can rename them, copy them to your computer (drag-

and-drop or cut- and-paste), delete them, and open

them with an application (FV2200, a spread sheet, etc.).

You can also create other directories on LAI, and

move any sort of file to them, but only files within the

Data folder will be accessible to the console’s software.

In the root directory of LAI, you may see some files

with .bin and .img extensions. The .bin and .img files

hold copies of the firmware for the console and wand.

Updating console or wand firmware involves down-

loading new files using the FV2200 "Check for Software

updates" (Help > Check for Software updates >

Show Wand and Console Information), putting them

in the root directory of LAI, and then telling the con-

sole to do the update (see sections 10-1 and 10-2).
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When wish to disconnect it from the computer, eject it

before unplugging it - just as you would with any USB

storage device.

About Data Files
File Format

Files generated by the LAI-2200 are text based and con-

sist of four basic parts: Header, Statistics, Sensor

Information, and Observations. These are described

below.
LAI_File SAMPLE2

Version 1.0.0

Date 20090924 15:23:12

Prompt1 Plot

Resp1 6

Prompt2 Trtmt

Resp2 2

TransComp  ACP

Model Horizontal

LAI 4.21

SEL 0.12

ACF 0.964

DIFN 0.028

MTA 46

SEM 12

SMP 8

MASK 1 1 1 1 1

ANGLES 7 23 38 53 68

AVGTRANS 0.286 0.032 0.016 0.021 0.029

ACFS 0.598 0.934 0.99 0.984 0.983

CNTCT# 2.078 3.377 3.296 2.35 1.353

STDDEV 1.433 0.615 0.223 0.192 0.12

DISTS 1.008 1.087 1.27 1.662 2.67

GAPS 0.123 0.025 0.015 0.02 0.027

### Contribu�ng Sensors

Sensor W1 PCH2516 3978 1244 1000 1004 1289

### Data
A 1 20090924 15:23:21 W1 199.23 198.96 202.21 186.61 190.67

B 2 20090924 15:23:55 W1 2.483 2.336 2.688 3.113 4.219

B 3 20090924 15:24:02 W1 7.436 2.631 2.15 3.345 4.141

B 4 20090924 15:24:08 W1 128.27 17.03 4.1 3.341 4.031

B 5 20090924 15:24:15 W1 83.73 6.755 3.677 2.986 5.03

A 6 20090924 15:24:26 W1 180.92 207.22 216.94 192.78 190.3

B 7 20090924 15:24:39 W1 32.46 4.261 2.506 8.798 11.12

B 8 20090924 15:24:46 W1 160.44 11.91 5.148 3.233 5.847

B 9 20090924 15:24:55 W1 12.92 3.185 2.461 3.872 5.312

B 10 20090924 15:25:02 W1 6.688 4.448 3.827 3.935 3.988

A 11 20090924 15:25:21 W1 172.05 190.29 216.11 210.73 191.75

Header

Statistics

Sensor 

Information

Observations

Header

The header is a group of fields at the top of the file. It

includes the file name, console firmware version, time

stamp indicating when the file was created, and user

remarks. The remaining part of the header contains the
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result of LAI calculations: leaf area index (LAI), stand-

ard error LAI (SEL), apparent clumping factor (ACF),

diffuse non- interceptance (DIFN), mean tilt angle

(MTA), standard error MTA (SEM), and the number of

pairs of Above and Below observations that were

included in the calculations (SMP).

Statistics

The statistics group contains 8 groups of 5 numbers:

MASK indicates which rings were included in cal-

culations (1 indicates the ring is included, 0 indicates

omission). ANGLES are the midangles of the field of

view for each of the 5 rings. CNTCT# are the mean

contact frequencies (the logarithm of the gap fraction

divided by the path length), STDEV are the standard

errors of the contact frequencies, DISTS are the path

lengths, and GAPS are the gap fractions. ACFS is the

apparent clumping factor for each ring, and

AVGTRANS is the average transmittance for each ring

in the file. Chapter 9Theory discusses how these quant-

ities, as well as those in the header, are computed.

Sensor Information

This field indicates which sensors were used to record

the data and the name of the wand used. The five val-

ues to the right are matching values for each ring in the

sensor. If light sensors (quantum, pyranometer, or pho-

tometric) were connected to port 1 or 2, the light

sensor name and calibration information would be in

this field too.

Observations

The Observations each have a label (A or B indicating

above or below the canopy), a sequential number, a
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time stamp, and the readings from the five rings of the

detector. In this example, the first four samples (B read-

ings 2 through 5) use A reading 1 as a reference. The

next four samples (B readings 7 through 10) use the A

reading 6 as a reference. Light sensor observations

would be labeled 1 or 2, and would be visible in the

rows.

What do the Results Mean?

LAI is the answer to the question “How much

foliage?”. Although LAI nominally means “leaf area

index”, please remember that the LAI-2200 is meas-

uring all light-blocking objects, so “foliage area index”

is more appropriate. LAI is dimensionless, but it can be

thought of as {m2 one-sided foliage area/m2 ground

area}. However, if the Model is not Horizontal (that is,

if the DISTS values have been changed to reflect meas-

urements of an isolated plant instead of an “infinitely”

horizontal canopy), then the LAI value is foliage dens-

ity (foliage area in m2/canopy volume in m3). See page

6-34.

SEL is Standard Error of LAI (Lse).

ACF is Apparent Clumping Factor. It is equivalent to

the apparent clumping indexΩapp defined by Ryu, et al

(2010). One of the assumptions the LAI-2200 makes

(page 1-6) is that foliage positioning is random - if not

for the entire canopy, at least for parts of it. For

example, consider a widely spaced row crop: The ran-

domness assumption is clearly wrong when con-

sidering the entire field, but is much better when

considering just one row. Lang and Xiang (1986)

showed that in cases like this, if multiple transmittance

measurements are made so that each contains either
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mostly row or mostly gap in its view, they can be com-

bined by averaging the natural logarithms of the trans-

mittances to give the correct leaf area index. For this

reason, the LAI-2200 combines multiple transmittance

readings by averaging the natural logarithms of the trans-

mittances when computing LAI (see Chapter 9

Theory). The ACF value is

ACF =
LAI

LAI

log(avg(T ))

avg(log(T )) 3-1

where LAIlog(avg(T)) is the leaf area index computed by

taking the log of the averaged transmittances, and

LAI avg(log(T)) is that reported by the LAI-2200 (com-

puted by averaging the logs of the transmittances).

Note that the simple averaged transmittances for each

ring are reported in the statistics block of the file, after

the label AVGTRANS, while the log- averaged trans-

mittances are reported after the label GAPS. Ring by

ring values of ACF are shown after the labels ACFS.

The purpose of ACF is to provide a way to "undo" the

avg(log(T)) protocol used by the LAI-2200 to combine

readings. Why would you want to do that? If, for

example, you had an independently determined clump-

ing factor Ω (determined, for example, from a gap size

distribution measurement) for a canopy that you

wished to apply to the LAI-2200 results, you would

need to do this to compute a true LAI (Ftrue)

Ftrue =
LAI × ACF

Ω 3-2

LAI × ACF undoes the clumping factor compensation
inherent in how the LAI-2200 works, and allows the

independently determined clumping actorΩ to be

applied.
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MTA answers “How is the foliage oriented?”. If all the

foliage were horizontal, then the correct MTA would

be 0°; if all were vertical, MTA would be 90°. This

information may not be of particular interest to every-

one, but it is wise to make sure the numbers seem at

least reasonable. Typically, MTA will range from the 30s

to the 60s, but an unexpected MTA value can indicate

something wrong with the measurement or the DISTS

values.

SEM is Standard Error MTA.

DIFN is calculated by integrating gap fraction (GAPS)

to yield a value that indicates the fraction of sky that is

not blocked by foliage. This value ranges from 0 (no

sky visible to the sensor) to 1 (no foliage visible to the

sensor). DIFN is in essence a single value rep-

resentation of canopy structure, as it combines LAI

and MTA into one number. However, DIFN does not

depend on the same assumptions that go into LAI and

MTA, but only depends on the assumption of no scat-

tering by the foliage. Of all the values computed by the

LAI-2200, DIFN comes the closest to being an indic-

ator of “canopy light absorption”. However, canopy

absorption involves not only canopy structure (DIFN),

but also the foliage spectral properties in the

wavelength range of interest (for example, the pho-

tosynthetically active 400 to 700 nm region) for the

foliage and the surface beneath the canopy, and the loc-

ation of the sun. Therefore, in terms of canopy

absorptance,DIFN is merely an indicator of the absorp-

tion of diffuse, short wave (<490 nm) radiation.

SMP is the sample size (total number of below canopy

readings).
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4 Measurement
Guidelines

This section includes practical considerations for data

collection procedures and guidelines for collecting data

under a variety of sky conditions.

Guidelines for Getting Good Data
Collecting reliable data with the LAI-2200 depends on

having a protocol that is appropriate for the canopy of

interest and suitable for the measurement conditions.

For any A orB readings that are used as a pair, the view

cap must be the same size, the optical sensor must

view the same part of the sky, and the view cap must

cover the same part of the sensor (this only applies if

the same sensor is used for both A and B readings).

When sky conditions are not ideal, adjustments may

need to be made in the measurement protocol. For

example, multiple B readings are generally required to

achieve a good spatial average; the view of the sensor

may need to be restricted to mask out the operator or

the sun; a dense canopy with large gaps may require a

narrowed field of view so that gaps and canopy can be

correctly integrated. These considerations are dis-

cussed below.
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Where to Measure?

A readings

In general, A readings should be made as closely as pos-

sible to B readings, both in time and space; however,

under certain conditions and with the appropriate pro-

tocol, this is not essential to acquiring good data.

In some situations, especially in forest canopies, it may

be impossible or impractical to record A readings near

the B readings. In these situations, it is best to use two

optical sensors (page 3-21), with one sensor positioned

above the canopy or in a clearing, logging data auto-

matically. Additional suggestions are in Chapter 5 Can-

opy Types.

B readings

It is best to consider a sampling protocol that is

designed for the canopy type that is being measured.

The best protocol for measuring a short homogeneous

canopy (such as a grassland) may not be the best pro-

tocol for measuring a row crop (and it certainly will not

be the best protocol for measuring a tall heterogeneous

canopy). Guidelines for measuring specific canopy

types are presented in Chapter 5 Canopy Types.

One approach to collecting B readings is to make meas-

urements equally spaced along one or more transects

under the canopy. Alternatively, measurements can be

made at randomly chosen locations in the study area,

though practical considerations periodically make this

difficult. Predetermined sample locations may violate

the guidelines for usage and require adjustments to the

sample location in order to collect valid data. For

example, avoid making measurements with a leaf
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immediately above the sensor, because one leaf may

block the entire view of the center rings. At the larger

zenith angles, when foliage is beside the sensor rather

than above it, an individual leaf blocks much less of the

view. The section called Foliage Size, beginning on

page 4-8, provides detailed guidelines for minimum dis-

tances and the theoretical justifications. Refer to Ross

(1981) for guidelines used for fisheye photography.

How Many B Readings?

When determining the proper number of B readings,

first consider the ground area over which the com-

puted LAI is to be valid: An entire field? Part of a field?

A small plot? Second, what fraction of this area does

one B reading represent? As a rule of thumb, consider

each B reading to represent a sample of the canopy that

is cylindrical (or some fraction of a cylinder if a view

cap is used) with a radius roughly equal to the canopy

height (the potential view of the sensor is larger than

this, but the effective range is reduced by foliage).

Thus,

A f̟H=
2 4-1

where A is the ground area represented by the sample,

f is the view fraction (0.75, 0.5, 0.24, or 0.125 for the

270°, 180°, 90°, and 45° view caps respectively), and H
is canopy height. For example, one B reading with no

view cap (f=1) in a canopy 5.0 m on a side and 1.0 m tall

is a sampling of approximately 3 m2, or 12% of the total

ground area. If that same canopy were only 0.2 m tall,

then one B reading would represent only 0.5% of the

ground area. Thus, canopy height is a very important

consideration.
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Another consideration is the variability of the density

of the foliage in the plot. A homogenous canopy

would require fewer B readings than a heterogeneous

one. Table 4-1 provides guidelines for determining the

proper number of B readings. See page 9-12 for the

derivation.

This simple procedure is used to determine the num-

ber of B readings necessary for 95% confidence that

the true LAI mean is within ±10% of the measured

LAI.

1. Make an LAI reading based on 6 B readings. Be

sure to include both the thinnest and densest parts

of the canopy.
2. Divide the Standard Error of LAI by LAI

(SEL/LAI)
3. Use the table below to determine the number of B

readings.

Table 4-1.

SEL/LAI Readings
# B 

SEL/LAI
# B 

Readings

0.01 2 0.06 11

0.02 3 0.07 13

0.03 5 0.08 16

0.04 6 0.09 19

0.05 8 0.1 23

Using View Caps

Use the 270° view cap to hide the operator from the

sensor anytime measurements will be made with the

operator potentially in the field of view. No view cap

would be needed if the operator were very careful to

block exactly the same portion of the sensor’s field of
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view for both A and B measurements, but it is simpler

to use the view cap.

In general, any object that is common to both the A

and B readings will not affect the LAI computation.

Thus, one could measure the LAI of grass beneath a

tree if the A and B readings are in close proximity so

that the tree occupies the same portion of the sensor’s

view for both A and B readings.

Here is a summary of reasons to use a view cap:

1. To remove the sun from the sensor’s view
2. To remove the operator from the sensor’s view
3. When sky brightness is very non-uniform
4. When there are significant gaps or clumps in the

canopy
5. To reduce the required plot size
6. To reduce the required clearing size for above-can-

opy readings in a forest

There are times when it is preferable to use the 180° or

270° field of view instead of a narrow one:

1. To avoid loss of signal near twilight or under very

dense canopies
2. If the goal of the measurement Le (effective LAI),

not L (true LAI).

Be very careful that the A and B sets of readings are

made with the sensor(s) viewing the same region of sky

without rotating the view cap on the sensor. This is

because there are usually slight azimuthal variations in

the sensitivity of the optical sensor’s detector, espe-

cially on the outer ring.

When using the view cap to block the sun, it is good

practice to shade the entire lens from the sun, to pre-

vent light reflected from the surrounding view cap
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structure from influencing the readings. Usually it is

only the 5th ring that responds to such reflections.

Measuring on Slopes

When making measurements on sloping terrain, hold

the optical sensor parallel to the ground rather than

level. Make sure that all associated A and B readings are

made with the sensor tilted at the same inclination and

pointed in the same compass direction.

Tilt the sensor...

...to match the slope.

One way to ensure that the sensor is held at the same

inclination for each reading is to mount the bubble

level on the handle rather than the sensor. Fix the

hinge at an angle that permits the handle to be held

level while the sensor is held at the desired inclination.

Mark the two pieces at the hinge so that this angle can

be reset easily.

Level the handle, tilt 

the sensor to match the slope...

...and mark the angle.

If it is impossible to incline the “above” and “below”

sensors at the same angle when measuring on a slope,

the effects can be minimized by using a 45° view cap,

and orienting the sensor for B readings along the
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contour (looking neither uphill nor downhill). The A

readings need to be taken at the same compass dir-

ection as the B readings.

Bad Readings

Theoretically, B readings should always have lower val-

ues than A readings. In very sparse foliage they will be

very close, and in large gaps where no foliage is seen by

the sensor, they will be identical. But that is only in the-

ory.

As a practical matter, a B reading may exceed the value

of its A reading for one the following reasons:

1. Changing sky conditions
2. Normal measurement variation
3. Operator error (A and B out of sequence)
4. MakingB readings in sunlit foliage (this is also oper-

ator error)

A B reading is “bad” if one or more of the rings has a

value that exceeds its associated A reading, so that the

transmittance for that ring is greater than 1.0. If this is

due to operator error or changing sky conditions, it

would be good for the operator to be alerted so that

the measurement can be started over. But, if a reading

is bad simply because of sparse foliage and normal fluc-

tuations, it would be nice for the console to overlook

the slight discrepancy and proceed using a value of 1.0

for the transmittance(s) of the offending ring(s).

To determine this setting, go to the Main Menu >

Log Setup > Transcomp > and scroll down to Bad

Readings. Select one of the settings described below

(press OK to save the setting).
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Skip: When a transmittance greater than 1.0 is found,

that B reading is ignored in the calculation. The offend-

ing record is still stored in the file, however. You will

know that a bad reading occurred if the number of B

readings is larger than the sample size in Logging Mode

(see page 3-13). Skip should be used in cases where A

and B readings are not expected to be very close.

Clip: If a transmittance greater than 1.0 is encountered,

it is considered to be simply 1.0. Note that this does

not change any stored values. This mode is useful

when measuring in canopies where B readings are likely

to be made under little or no foliage.

Foliage Size

As a general rule, the distance between the sensor and

the nearest leaf above it should be at least four times

the width of the leaf. When a view cap is used this dis-

tance should be increased, but when more B readings

are taken the distance can be decreased.

Table 4-2 provides guidelines for determining the min-

imum distance from the sensor as a function of foliage

element size and zenith angle. To determine how close

a particular leaf size can be to the sensor, find the

column for the view cap being used in Table 4- 2.

Divide the values by the number of B readings to be

made and multiply the results by the leaf width (cm).
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Table 4-2.

Distance Factors

Sensor Field of View:

Ring Angle (°) 360° 270° 180° 90° 45°

1 7  10 20 30 50 100

2 22  4 5 8 20 30

3 38  3 3 5 10 20

4 52  2 3 4 8 15

5 68  2 2 3 7 14

The formula for determining whether a leaf is too close

to the sensor is:

( )minimum distance=
d w

B

×
4-2

where d is the distance factor from Table 4-2, B is the

number of B readings, and w is the leaf width (cm).

For example, with no view cap and only one B reading,

a 5 cm leaf should be 50 cm ((10/1)×5) away at 7°, 20
cm ((4/1)×5) away at 22°, and 10 cm ((2/1)×5) away at
68°.

Derivation of Eqn. 4-2

One of the LAI-2200 assumptions (Chapter 1 Getting

Started) is that the foliage elements are small compared

to the sensor field of view. Lang and Xiang (1986)

derived a formula for the error as a function of foliage

area and sample area: If R is the ratio of sample area (the

region over which gap frequency determinations are

made) to the area of an individual leaf, then the factor

(E) by which the gap frequency is in error is
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( )E = −Rln 1 −
1

R
4-3

We apply this analysis to an LAI-2250 sensor by con-

sidering the sample “area” to be the distance around a

particular ring’s view at a distance from the sensor that

corresponds to the closest foliage. For example, the

view of ring #2 is centered at 22°. If the closest foliage
at 22° is 50 cm from the sensor, then the sample size

for that ring (assuming the full 360° view) is (2π)50(sin
(22))=118cm. If the leaf width is 5 cm, then R in equa-

tion 4-3 is 118/5 = 24, and the error is 1.02 or 2%.

Table 4-2 above is for an error (E) less than 5%, requir-

ing the ratio of view circumference to leaf width (R in

equation 4-3) to be at least 10.6.
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Sky Conditions
Measurements with the LAI-2200 can be made under a

variety of sky conditions. Obscured sun is best, but

measurements can be made on clear days in the proper

settings and with the proper techniques.

Direct Sun

Try to avoid making measurements under direct sun-

light by working at sunrise, sunset, or on a cloudy day.

If measurements must be made in direct sunlight, fol-

low these procedures:

a. Make all A and B readings with your back to the

sun, with the view cap blocking the sensor’s view

of you and the sun.
b. Make sure your head or another object shades the

sensor whenever an A or B reading is made. Even

though the view cap prevents the detector from

seeing direct sun, shading the optics prevents

reflected sunlight from influencing readings.
c. If possible, shade the part of the canopy that is vis-

ible to the sensor. The more sunlit leaves the sensor can

see, the larger the underestimate of LAI. This is especially

true in short canopies (which, fortunately, are easier

to shade), because leaves in tall, dense canopies

tend to be shaded by the top of the canopy.

The amount of sunlit foliage seen by the sensor (and

thus, the LAI underestimate) depends on many things,

including sun angle, foliage angle distribution, and

foliage distribution. If the canopy is not shaded, you

will find that LAI measurements seem to be a function

of time of day.
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Welles and Norman (1991) found that measurements

made in direct sunlight were 11 to 56% lower than cor-

responding measurements made with the sun

obscured.

Canopies that are fairly uniform and don't have large

gaps are more accurately measured in direct sun than

non-uniform canopies with large gaps. Typically, you

could expect underestimates in LAI of 10% in uniform

canopies without large gaps. The problem comes with

large gaps: if you have below canopy readings in which

the sensor is viewing a lot of sunlit foliage (e.g. edge of

a forest clearing, looking at the side of a sunlit spruce

tree), then much larger underestimates can be expec-

ted.

Sometimes, you just have to find a way to deal with dir-

ect sun. Suppose you have many transects to measure,

and they cannot be done in the relatively brief time

afforded near sunrise or near sunset. Further, there is

no hope of clouds during the day. Let's make it a forest

canopy, so you cannot shade anything, and hardly uni-

form, so there are lots of gaps so you cannot ignore the

sun's effect.

What do you do? Try this: pick out a couple of rep-

resentative transects that you can measure when the

sun is low. During the day, make all of the meas-

urements, following the advice on page 4-11 (i.e. use an

appropriate view cap, and always keep the sun in the

blocked portion of the view). Then, when the sun is

low, repeat the measurements on your representative

transects, collecting data at exactly the same points, if

possible. Use those transects to compute a "sun

effect", by comparing the LAI results with and without

direct sun, and apply that correction to the rest of the
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transects. A variation on this, if you have trouble with

the notion of a "representative" transect, is to pick two

or three transects that span the range of clumping

factors that you have, and compute the direct sun

effect as a linear function of ACF, then compute and

apply your correction factor on the rest of the transects

that way.

Scattered Clouds

Measurements can be made under scattered clouds if

the appropriate sampling technique is used. If possible,

wait for the sun to be obscured by a passing cloud

before making measurements. If clouds are moving rap-

idly, minimize the time between A and B readings (a

few seconds is preferable) and/or the distance

between A and B sensors.

Very Non-Uniform Overcast

If the sky has distinctly bright and dark regions, there is

greater potential for error when measuring non-uniform

canopies. The part of the canopy that lies in the dir-

ection of the brightest part of the sky will contribute

the most to measurements. One solution is to narrow

the sensor’s field of view so that the bright and dark sky

are not included in both the same readings.

a. Reduce the field of view with a view cap so that the

region of sky viewed at any one time is as large as

possible, but still uniform.
b. Make A and B readings with the sensor viewing the

dark part of the sky; then repeat the sequence with

the sensor viewing the bright part of the sky. Be

sure the sensor is viewing the same region of sky

for all associated A and B readings.
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c. Minimize the time between A and subsequent B

readings, especially if low, fast-moving clouds are

present.

Clear Skies

Clear skies are good in that they are uniform. Inter-

polating over time works well, and large distances

between A and B sites are tolerable. If the sun is at or

below the local horizon (no sunlit foliage is visible to

the sensor), then blue sky is ideal. However, if the sun

is illuminating foliage in the sensor field of view, then

LAI will be underestimated. To determine the extent

of underestimation, measure LAI in the same locations

just before sunrise or after sunset. Compare this meas-

urement to one made during mid-day.

Rain, Fog, and Dew

Accurate measurements can be made in wet canopies if

care is taken to keep water droplets off the lens. Work-

ing in rain is also possible, but measurements will have

greater uncertainty. Droplets on the lens present a con-

cern because they block light. A few small droplets can

reduce the light seen by some rings by 10% or more.

Therefore, it is important to keep the lens free of

droplets by wiping it with the cloth provided in the

Lens Cleaning Kit.
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5 Canopy Types
This section includes suggested protocols for meas-

uring LAI in various canopy types. It also describes

some relevant considerations and suggestions for

acquiring the best data in different canopy types.

Measuring Plant Canopies
Short Homogeneous Canopies

Short homogeneous canopies are the simplest to meas-

ure. Under stable sky conditions with a 270° view cap,

one A reading for four or more B readings should be

sufficient. To reduce uncertainty of measurements,

you can take more B readings.

Small Plots

When measuring small plots, it is important to be sure

that objects outside the plot do not influence meas-

urements. From beneath a canopy, the sensor’s poten-

tial view is conical, with a radius that is about 3 times

the canopy height. The sensor has a view of 74° (tan
(74)=3.48). However, 3 serves as a working number

because of the reduced probability that foliage will be

significant at the edge of the sensor’s field of view.
The sensor view is about 3 times the 

height of the canopy.
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In a canopy that is 1 m high, the sensor should be at

least 3 m from the edge in any direction that it can

“see”. In a plot so small that the sensor will “see” out-

side the plot area if measured from the middle, one

could use a 90° view cap and make readings from the

corners looking into the plot. Alternatively, a 180° view
cap could be used if the measurement were taken near

the center of the plot.

Above-canopy Reading

and the associated 

Below-canopy Reading

In dense canopies, the minimum plot size may be

reduced if foliage blocks enough of the sensor’s view.

This is easily tested by getting down on the ground and

looking up at about a 30° elevation angle. If you are
unable to see the edge of the plot from this vantage

point, then the plot is large enough regardless of its

actual dimensions.

An additional method for measuring small plots is to do

the LAI computations without the outer ring. Without

the outer ring, the minimum plot size decreases to 1.6

times the canopy height. The outer ring can be omitted

with the Mask function prior to data collection
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(beginning on page 3-5), after data collection on the

control unit (beginning on page 3-25), or after data col-

lection using the FV2200 software (page 6-29).

Row Crops

Row crops, with architecture ranging from very wide

row spacing to closed canopy, can be measured accur-

ately using the technique described here. In general,

readings should be made along diagonal transects

between the rows, as shown in Figure 5-1. Choose loc-

ations along transects so that readings are made at even

intervals across the row. For example, if making 4 B

readings per transect, make the first in the row, the

second ¼ of the way between the rows, the third at

mid-row, and the fourth ¾ of the way across. Meas-

uring with a diagonal transect, rather than a per-

pendicular transect, improves spatial averaging.

Above-

canopy

Readings

Below-

canopy

Readings

Rep 1Sequence=ABBBB Rep 2

R
o

w
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e
n
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e

Figure 5-1. A row crop with a homogeneouscanopy (e.g., no
gapsbetween rows) can bemeasured with a wide view cap.
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Be sure to make all B readings at the same height; if fur-

rows and mounds cannot be smoothed, position a

board along the transect and rest the sensor on it when

taking readings.

If the rows have significant gaps where vegetation is

lacking, perform the Canopy Gap Test (page 5-10) to

see if these gaps merit special attention. If the Gap Test

error is less than 10% (homogeneous canopy), then use

as wide a field of view as possible, depending on sky

conditions. If the Gap Test error is greater than 10%

(heterogeneous canopy), then use the 45° view cap and
double (at least) the number of diagonal transects.

Measure the transects in pairs: one transect with the

sensor looking along the row, and the other with the

sensor looking across the row, as shown in Figure 5-2.

Above-

canopy

Readings

Below-

canopy

Readings

Rep 1Sequence=ABBBB Rep 2 Rep 3 Rep 4

Figure 5-2. A row crop with a heterogeneouscanopy (e.g.,
gapsbetween rows) may require a narrow view cap andmore
repetitions.
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Tall Canopies and Forests

The primary challenge to measuring very tall canopies is

getting the A readings. Also, because it is impossible to

artificially shade such a canopy, it will be difficult to

make reasonable measurements during sunny days,

unless the canopy is so full and dense that sunlit leaves

are not visible to the sensor, or unless readings are

made in early morning or late evening.

Method 1: Two-sensor mode is the obvious solution

for obtaining above-canopy readings. Two LAI-2270

Optical Sensors are required, with one located above

(or out of) the canopy and automatically recording A

readings in autonomousmode. The other is used to col-

lect the B readings. Data from the two sensors can be

merged to calculate the desired variables (see page 3-21

for a step-by-step example).

Method 2: A single sensor can be used effectively. Fol-

low the protocol described on page 3-20, except set

Transcomp to “Interpolate” (page 3-6). Record one A

reading in a clearing or above the canopy. Proceed with

recordingB readings under the forest canopy in accord-

ance with your protocol. After collecting a number of

B readings, collect a second A reading. LAI values will

be visible in logging mode. The “Interpolate” setting

fits a linear function to the A readings for each ring and

predicts the appropriate above-canopy values based on

the time of each B record,

Method 3: This is a combination of Methods 1 and 2. A

sensor configured for autonomous logging in two-

sensor mode is used to log continuous A readings in a

clearing. A second sensor, configured to record A read-

ings that bracket the B readings, as described in
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Method 2 above, logs its first and last A readings next

to the sensor that is recording the series of A readings.

Using this method, it is no longer necessary to rely

totally upon the second optical sensor for A readings,

nor is it necessary to rely on a linear interpolation of A

readings from the unit that collected the B readings.

LAI can be computed for each method and compared.

Another advantage is that this method automatically

provides the data necessary to calibrate the two sensors

to each other, which removes the need to match the

sensors beforehand.

Making A Readings in Forest Canopy

There are several considerations for getting A readings

in a forest canopy.

A readings should be made as close as possible to the

site to be measured. The maximum acceptable distance

depends entirely on sky conditions. With blue sky

(ignoring the sun for a moment), the two sensors could

be kilometers apart and still see the same sky brightness

distribution. With an overcast sky, however, the lower

the clouds, the greater the probability that two sensors

some distance apart will see different skies, especially

with the central rings (near the zenith). A low, inhomo-

geneous overcast sky with quickly moving clouds is the

worst case, when even 100 meters could be too great a

distance between the sensors.

Ifmaking A readings in a clearing, be sure that the clear-

ing is big enough. With a 180° or larger view cap, the
sensor should be in the middle of a clearing with a dia-

meter at least 7 times the height of the trees above the

sensor (2×tan74°≈7).
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Clearing should be 

7x wider than the height 

of surrounding trees

With the 90° or 45° view cap, however, a clearing half
that size (diameter only 3.5 times the tree height) can

be used, since the sensor can now be positioned on

the edge of the clearing (looking in).

Clearing 

should be 3.5x 

the height of 

surrounding trees

This is a common reason for using a narrow view cap in

a forest. Neglecting the outer ring may be necessary if

an adequately large clearing is not available. In that case,

the clearing should be 1.5 times the canopy height if
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the 45° or 90° view cap is used. Refer to the “Small

Plots” discussion earlier in this chapter.

When making A readings for forest canopies, clearings

can be made “bigger” by raising the sensor. Use the bot-

tom level and hold the sensor over your head. The

sensor can be elevated by standing on a stump, the cab

of a vehicle, or by raising the sensor with a long pole,

etc.

Don’t forget: The A readings should be made with the

same view cap (covering the same part of the optical

sensor), sensor inclination (if the ground slopes), and

direction of view that the B readings will have.

Canopies with Large Gaps

LAI is proportional to the logarithm of the gap fraction,

so the proper way to average gap fractions is to average

their logarithms (Lang and Xiang, 1986). This in fact is

how the LAI-2200 averages multiple B readings in a

file. However, each B reading is a linear average of the

light from whatever azimuthal view is visible to the

sensor, as determined by the view cap. Problems can

arise if the sensor sees dense foliage in one direction

and little or no foliage in another direction at the time a

B reading is recorded, because the gap in the canopy

will be “over weighted”, and LAI will be under-

estimated. A way to avoid this problem is to use a view

cap to restrict the sensor’s field of view, so that dense

and sparse regions of the canopy are included in sep-

arate B readings. The figure below illustrates how a 45°
view cap helps isolate a gap near a transect.

If on the other hand, you wish to measure Le (effective

LAI), then you do not want the instrument to log aver-

age. In this case, use a wide field of view (270°), and
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multiply your resulting LAI by ACF, the apparent

clumping factor (3-2-).

The Canopy Gap Test (page 5-10) can be used to estim-

ate the error of using a wide field of view in a het-

erogeneous canopy, when large gaps and foliage are

included in the same B reading.

Conifers

It is well known that conifer needles are not arranged in

space randomly, and radiation penetration models that

make that assumption will underestimate the trans-

mittance of a conifer canopy (for example, Norman and

Jarvis, 1975; Oker-Blum and Kellomaki, 1983). Since the

LAI-2200 assumes random foliage positioning, it will

underestimate LAI in conifer canopies.

Numerous researchers have developed sampling tech-

niques for acquiring accurate LAI measurements in

evergreen forests, including Chen (1996), Stenberg

(1996), Chen et al. (1997), and Kucharik et al. (1998). A

detailed sampling protocol for conifer stands is

described in Law et al. (2008).
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The Gap Test

The canopy gap test is a quantitative way to estimate

the error of using a wide field of view in a het-

erogeneous canopy. That is, a canopy with dense

foliage in some areas and sparse (or no) foliage in oth-

ers. The problem is that LAI is proportional to the log-

arithm of the gap fraction, but for any one reading, the

sensor will linearly average gap fraction over its view. If

the sensor’s view includes both dense and sparse

foliage areas, the gap fraction for that B record will thus

be incorrectly averaged. If the dense and sparse regions

are measured in separate B records, they will be cor-

rectly averaged.

A simple method of estimating the error of using too

large a view cap is to do the following:

1. Use a 45° view cap.
2. Set Transcomp to A-P-C (Above, Previous, and

Clip).
3. Make a measurement in the canopy consisting of 2

AB pairs. Both of the below readings should be in

the same location, but one viewing the densest part

of the canopy, and the other viewing the sparsest

part. (Because they are viewing different directions,

you need separate A readings for each B reading.)

Look at the value of ACF, apparent clumping factor.

For purposes of this test, interpret this as the ratio of

the LAI you would get with a wider view cap to the

one you would get with the narrower view cap. For

example, an ACF of .95 means the wider view cap

would produce an LAI that is 5% lower than that

found with a narrow view cap. An ACF of 0.8 would be
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20% lower, and so on. The lower the ACF, the more

you need the narrow view cap.

Measuring Isolated Plants
This section describes the measurement of isolated

plants, for which a different protocol must be used. We

begin with a discussion of LAI and foliage density.

LAI or Foliage Density?

LAI is one-sided leaf (or foliage) area per unit ground

area. In a large, homogeneous plant community, LAI is

a reasonable way to express the amount of vegetation.

An isolated plant presents difficulties, however,

because the amount of foliage over a given area of

ground depends on ground position. For example, con-

sider a single tree:

The amount of foliage above a unit

ground area at the tree’s center…

…is probably different than the

amount of foliage near the tree’s

edge.
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Also, the ground area affects the

LAI measurements. For

example, we might wish to

express LAI based on the tree’s

drip line area, or based on the

area associated with the tree as a

memberof a community, as illus-

trated in the over-head view

below.

Thus, LAI for an isolated plant is ambiguous unless the

size and position of the ground area is also given.

A more useful measure of foliage amount for individual

plants, or clumps of plants, is that of foliage area dens-

ity (or simply foliage density), which is foliage area

divided by canopy volume. Foliage density has units of

m2 foliage area per m3 canopy volume, which reduces

to units of inverse length, typically m-1. If a tree has 2

m2 of foliage in a 5 m3 crown, its foliage density is 0.4

m2/m3, or 0.4 m-1.
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The DISTS Vector

In Chapter 9 Theory, which describes the theory of the

LAI-2200, it is shown that the only theoretical dif-

ference between measuring LAI and measuring foliage

density involves something called the DISTS

(Distances) Vector.

The DISTS Vector is a group of 5 numbers in the con-

trol unit that are used in the computations. These num-

bers indicate the distances sky radiation must travel

through the canopy to reach each of the 5 detector

rings of the sensor. They can be viewed on the console

by navigating to Menu > Log Setup > Distances .

The default values in this vector are 1/cosθ , where
angle is the view associated with each of the five rings

(7°, 23°, 38°, 53°, and 68°). When making LAI meas-
urements, there is no need to adjust these values since

1/cosθ is sufficient regardless of canopy height.
Foliage density measurements, however, require that

the DISTS vector indicate the actual mean path lengths

that each ring sees through the canopy. When results

are computed, the LAI value is now foliage density.

The units of foliage density depend on the units used

for the DISTS values. If distances are entered in m,

then the foliage density is in m-1.

To set the DISTS vector for new data, go to Menu >

Log Setup > Distances. To change the DISTS vector

for an existing data file, go to Menu > Data > Con-

sole Data. Select a data file, then Edit > Edit Dists.

A Simple Example

Consider a perfectly hemispherical shrub with a radius

of 0.7 m. A hemisphere is the simplest because the
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path lengths for each ring view are identical.

7°
23°

38°

53°

68°

To measure the foliage density of this shrub, access the

Distance vectors (Menu > Log Setup > Distances )

and set each of the five values to 0.7. The measurement

is similar to that for LAI, except that a spatial average

under the shrub is now not wanted; we will take only

one B reading, directly under the center of the plant.

This example is discussed further on page 7-1.

Isolated Trees

Trees are best measured using the 180° or smaller view
cap, and placing the sensor next to the trunk below the

crown for B readings. The view cap prevents the

sensor from seeing the trunk of the tree. Usually, you

will put the sensor above or below the largest branches

in the crown because it is important to avoid having

these branches dominate the sensor’s view. Place the

sensor just above the low branches (Method 1) or place

it well beneath them out of the canopy (Method 2).

Both techniques are illustrated below:
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Method 1 Method 2

7°

23°

38°

53°

68°

7°

23°

38°

53°

68°

The thick segments of the diagonal lines in this figure

indicate the distances each ring sees through the can-

opy. Note that sometimes a ring will see no foliage, as

with the 68° ring in Method 2 above. A ring that sees
no foliage should be masked (see page 3-6). A 90° or
45° view cap can be used to further reduce the size of
the canopy that is sampled. The view cap and view dir-

ections should be chosen to avoid including neigh-

boring trees in the measurement.
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If a tree is symmetric and well isolated, several B read-

ings can be taken in different directions. The figure

below illustrates measuring a tree with 4 B readings 90°
apart, but a better average could be obtained with 12 B

readings 30° apart, for example.
Note: all associated above and below readings must be viewing the

same portion of the sky.

Above

Below

Below

Below

Above

Below

AboveAbove
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If a tree is asymmetric, then the path lengths through

the tree (and thus the distance vector) will depend on

azimuthal direction. Since only one distance vector is

associated with a file, asymmetric trees should be meas-

ured using several files. Average foliage density is then

computed by averaging the foliage densities from each

of the files.

Below

Below

Below Below

Above

Above

AboveAbove
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A simple method for computing path lengths and can-

opy volumes is provided in the FV2200 software (see

page 6-24). Use a coordinate system centered below

the tree, and determine the coordinates of a sufficient

number of points to describe the shape of the canopy.

Alternatively, a photograph of the tree that includes a

meter stick for scale can be used to obtain the tree pro-

file.

An example of the measurements needed to describe a

tree crown are shown below:

1 2
3

4

5

6

7

       X    Z

1: (0.0, 0.6)

2: (0.8, 0.6)

3: (1.4, 0.8)

4: (1.6, 1.5)

5: (1.3, 2.3)

6: (0.8, 2.8)

7: (0.0, 3.3)

The FV2200 software can use these data to determine

path lengths, neglect rings if necessary, and compute

canopy volume, foliage density, or dripline LAI.

Refer to page 7- 3 for detailed examples, including

descriptions of the use of FV2200 to compute the vari-

ables of interest.
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Isolated Rows and Hedges

The measurement of individual rows (e.g. hedges,

grape vines) is possible with the LAI-2200. Again, the

data should be treated as foliage density. Here we

describe two methods for measuring isolated rows or

hedges.

Method 1

The measurement of isolated rows, such as a hedge or

the rows in a vineyard, is similar to measuring isolated

trees. With this method, the above and below meas-

urements are taken along the length of the row.

Below

Above

Above

Above

Above

Below

Y
X

For the below-canopy readings, place the sensor near

the row center and orient the view cap so that the

sensor looks away from the center. Keep it close to the

lowest vegetation, but far enough away from any leaves

to ensure that individual leaves do not block the view

(see page 4-2).
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Next, characterize the canopy shape by measuring a

number of X, Z coordinates. The number of coordin-

ates required will vary, depending on the complexity of

the canopy shape. If the canopy is asymmetrical, char-

acterize each side with X, Z coordinates. Measure or

estimate the row ratio for the hedge (the length Y over

width X). These values are used by FV2200 software to

compute the foliage density or dripline LAI.

1

2 3
4

5

    X        Z

1: (0.0,   0.5)

2: (0.0,   1.97)

3: (0.31, 1.89)

4: (0.51, 1.77)

5: (0.67, 1.55)

6: (0.63, 1.29)

7: (0.54, 1.01)

8: (0.25, 0.64)

6

7

8

X

Z

Forasymmetrical canopies, LAI would need to be com-

puted for each side of the canopy. LAI for the hedge

would be the average of LAI for both sides. A com-

plete example, including sample data, is presented on

page 7-6.
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Method 2

A simple way to measure LAI in a hedge is to take an A

reading viewing the sky. Take a number of B readings

on one side of the row or the other, being sure that the

sensor “sees” through the hedge, as shown below. It is

useful for both symmetrical and asymmetrical canopies.

Above

Above

Below

Y
X

In addition to the above and below-canopy readings,

measure X, Z coordinates to characterize the shape of

the entire canopy, measure the distance between the

sensor and the hedge centerline, (the X offset in

meters), and the distance between the sensor and the

bottom of the canopy, (the Z offset in meters). Meas-

ure or estimate the row ratio for the hedge (the length

Y over width X). This information will be used in the

5
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FV2200 software to compute distances and LAI for the

shrub. In the figure below, the sensor was held at the

base of the canopy, resulting in a Z offset of 0.

1

2

3

4

5
    X         Z

1: (0.0,    0.5)

2: (-0.12, 0.75)

3: (-0.18, 1.09)

4: (-0.23, 1.44)

5: (-0.17, 1.77)

6: (0.0,    1.97)

7: (0.3,    1.89)

8: (0.51,  1.76)

9: (0.66,  1.54)

10: (0.63, 1.28)

11: (0.53, 1.01)

12: (0.24, 0.64)

6
7

8

9

10

11

12

X

Z

Make B readings 

with the sensor at 

the base of the 

vegetation or 

below the canopy. 

Measure the X and 

Z offsets from 

coordinate #1. In 

this case, they are 

-0.20, 0.5.

These data and a complete example are presented on

page 7-9.
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6 Data Analysis with
FV2200

Introduction to FV2200
FV2200 allows easy manipulation of LAI- 2200 and

LAI-2000 data files (hereafter referred to as LAI files).

These files can be read from disk, or imported from

either console type (LAI-2200 or LAI-2000). LAI files

can be manipulated in any way that they can on the con-

sole, and in many other ways besides.

Installing FV2200
The installation CD will work on Windows® and Mac

OS®X computers.

Windows

®

A splash screen should open automatically when the

CD is inserted. To install the FV2200 program, click the

“Install FV2200” button.

Macintosh

®

To Install FV2200, drag and drop the FV2200.app pro-

gram to the Applications shortcut right next to it.

Linux

There is a folder on the CD named “Src”. In that folder

is a .tar.gz file. To install FV2200, copy this file to your
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computer, expand it, and follow the directions in the

“readme” file.

Main Window

When the FV2200 software is launched the main win-

dow will open. From this window, you can import LAI

files from or open LAI files from a disk.

Three tool bars are visible in the Main Window: File,

Display, and Edit. Toolbars can be hidden, moved

around or detached by clicking and dragging the tool-

bar drag handle.  Hide and show toolbars using the

View menu or by right-clicking on the menu bar.  To

resize buttons in the toolbars or change display

defaults, select File > Preferences (PC) or FV2200 >

Preferences (Mac). Choose between small icons (no

boxes checked), large icons, or icons with labels (small

or large).
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Transferring Data from the Con-

sole to a Computer

There are two ways to transfer data files from the LAI-

2200, and one way to transfer files from the LAI-2000.

These are described below.

USB File Transfer

When the LAI-2270 Control Unit is attached to a com-

puter with the USB cable, it will be recognized as a

mass storage device (see page 3-26). Do not attempt to

use RS-232 and USB simultaneously.

RS-232 File Transfer – LAI-2200

The Acquire Wizard can be used to transfer files using

the RS-232 connection from an LAI-2200 (below) or an

LAI-2000 (page 6-5). Be sure the USB port is not con-

nected to a computer when using RS-232 transfer.

1. Attach the RS-232 cable to the DB-9 port on top of

the LAI-2200 and attach the other end to the 9-pin

serial port on your computer.
2. Launch the Acquire Wizard by clicking the

Acquire button or by clicking File > Acquire.
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3. Check the LAI-2200 radio button and click “Next”.
4. Select the correct serial port. On Windows, the

name will be COM1, COM2, etc. On Macs, you will

need a USB-serial converter, and the name will be

/dev/cu, followed by some name that depends on

what converter you are using (e.g. /dev/cu.usb-

serial-FTDEIPXP). On Linux, it will be /dev/tty...

or dev.usb…Click “Next”.
5. Select the files you would like to copy, then click

“Next”.
6. Choose the destination of the file(s): You can route

them to a view (either a new view, or add them to

an existing view, if any), and/or save them directly

to one file, or multiple files preserving the original

file names.

7. After the transfer is compete click Finish. The file

(s) will be visible in a tab sheet (view) if that was

your choice.
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RS-232 File Transfer – LAI-2000

The steps below describe how to import data from an

LAI-2000 using FV2200:

1. Click the “Acquire” button to launch the Acquire

Wizard. Check the LAI-2000 radio button and click

“Next”.
2. Connect the LAI-2000 to the serial port on your

computer with a 9-pin RS-232 cable. On the LAI-

2000, press FCT 31 and enter the following settings:

Baud=4800; Data bits=8; Parity=none;

XON/XOFF=NO.
3. Press FCT 33 and enter the following: Format:

Standard; Print Obs: YES.
4. Click “Next”.
5. Select the serial port that is attached to the

LAI-2000 and click “Next”.
6. Choose whether you would like to route to a view

(check “Add to View”), save the file, or both. You

may open the files in any of the current view tabs

or a new view tab, and save multiple files as one file.
7. On the LAI-2000, Press FCT 32 and enter the page

range. The incoming data will be displayed in the

Wizard window, as well as routed to a view and/or

saved in a file, depending on what you selected.
8. Click “Finish” and the FV2200 will process the last

file that was downloaded. Note that the last file

received will not be processed (added to a view, or

written to disk) until you press the Finish button.

Viewing Files

To open files that are saved on your computer’s hard

drive or the LAI-2200 console if it is attached via USB,

click the “Open” icon or File > Open and navigate to
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the stored file. Double click the file to open it, or select

multiple files and clickOK.

Alternatively, you can drag the data file(s) onto the main win-

dow: The file(s) will be opened in the current view, or if

there are no views, one will be created.

On Mac and Windows operating systems, you can drag

and drop the data file(s) onto the FV2200 icon : on Mac, if

FV2200 is not running, it will launch, create a view, and

open the files in that view. If FV2200 is running, this is

just like dropping the files onto the main windows On

Windows, FV2200 will launch (if it is already running, a

second one is launched), a view is created, and the files

opened in the view.

If multiple files were selected, click “Yes” to place

them into one tab or “No” to place them in separate

tabs. Once files have been opened, a view is created

with the tab showing the source files. If you open

another file or group of files, these will go into a

second view. LAI files (rows of a view) can be cut,

copied, and pasted from one view to another.

The bottom section of the Main Window is the Log

frame, in which a log of activities is displayed.
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Column Headings

You can choose which column headings are displayed

in all views by clicking View > Display or the Display

icon. Data can be sorted by right-clicking a data file and

selecting “Allow Sorting” from the Main Window.

Click a column heading to sort the data. Click again to

reverse the sort order.
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Selecting Files in a View

Most of the FV2000 tasks have options for operating

on selected or all LAI files in the currently view. If no

files are selected, the task will operate on all files in the

view. LAI files in a view can be selected by clicking on

them. Multiple files can be selected using ctrl + click

(⌘ + click on Macintosh) for non-contiguous entries,

or shift + click for an entry range.

Viewing File Details

If you double click on an LAI-2200 file in a view, a File

Details window will open. This is described in the File

Details section (page 6-32).

Adding Charts

You can add one or more charts by clicking the Add

Chart button.
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Select the variables and settings for the chart and click

OK. If the “LAI Files:” field was set to “Selected or

ALL” or “Selected Only”, you can change the file that

is displayed simply by selecting one or more files from

the Main Window after creating the chart. Right click

on the menu bar to recall a list of charts that were cre-

ated recently.

Right click or double click on the chart area to open

the Chart Context menu with options for editing the

chart, choosing the data source, changing page size for
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printing, printing, saving the chart as a .pdf file, or

removing charts. This is described in more detail on

page 6-46.
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Common Tasks
Excluding Rings from Analysis

Mask attributes can be changed in the FV2200 soft-

ware. For more information, see Masking Rings on page

6-29.

1. In the Main Window, select the files that you wish

to recompute, and click the Recompute button (or

clickEdit > Recompute). The Recompute Obser-

vations dialog box will appear. Alternatively,

double-click a data file to open the File Details win-

dow, select the Header tab and click Change…
2. Check the Change Mask box, then unselect the

box beside each ring that is to be omitted.

6
D
at
a
An

al
ys
is

w
ith

FV
22
00



LAI-2200 InstructionManual

6-12

3. Click OK. Changes to calculations will also be dis-

played in the “Log” section of the Main Window.

Expand a File

Sometimes it is of interest to expand a single LAI file

into multiple files in order to examine the spatial vari-

ability of LAI that the file contains. You can create a

new file for each B reading (and associated A reading)

found, or a new file each time the above-canopy read-

ing changes.

1. In the Main Window, select the files to be expan-

ded.
2. Click the Expand button or File then Expand….

A “File Expand” dialog box will open.
3. Select “Create a file for each Above/Below pair” or

“Create a file for each above-canopy and all asso-

ciated below-canopy records”.
4. If desired, select a new Transmittance Computation

method.
5. ClickOK to create the new files.
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The dialog box also allows you to change how

Above/Below pairs are determined (see Computing

Transmittance). If you do not enable this option, the

computationalmethod associated with each file is inher-

ited by its expanded files.

Combining Multiple Files

Sometimes it is desirable to combine the observations

from multiple files into one file. The reason for doing

this is usually to provide a properly weighted average of

LAI or ACF for multiple areas (files) based on the num-

bers of samples in each.

The files to be combined must be in the same view. If

none or only one file is selected, then all files will be

combined. If more than one file is selected, then you

have a choice of combining just the selected files, or all

the files in the view. You can name the resulting file.

Combining files creates a new file, with its own copy of

all the observations. It makes no changes to any of the

contributing files.

Note: Like any LAI file, a combined file will have only one

TransComp setting (canopy model, mask, etc.). Thus, if you need

to combine files that have different masks, for example, then this

version of combine may not work correctly for you.

1. Put files to be combined into the same view. If

there are files in that view that you do not want to

combine, then select only the ones you want.
2. Click on the combine icon, or do File > Combine.
3. Specify the name of the new file, and click OK.
4. The recomputed dialog will open. You can specify

details of how you want the computation done.
5. The new file will be computed and appended to

the current view.
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Importing Readings from Separate

Files (FV2200)

When A and B readings are in separate files, they must

be merged to compute results. If the A and B readings

were collected using two different sensors, the sensors

also need to be matched – that is, readings from one

sensor should be adjusted so that both sensors read

the same under the same conditions. This is accom-

plished with the Import Records tool.

The Import Records Dialog Box

Descriptions of fields in the Import Records dialog box

are below.

Dest files: This refers to the files that have the B read-

ings and need A readings. The program will try to find

A readings for each of the B readings in the destination

files. The dialog box gives two options:
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With LAI- 2200 data files, you will always use the

INSERT option. The REPLACE is for LAI-2000 data

files collected in Remote Below mode, which use “?”

as record placeholders.

Source files: This refers to the source of the A records.

The dialog box provides two options for selecting A

records:

“closest in time” will import the A record that is just

that; “interpolate” will cause the program to find the

nearest two A records in time, then use them to inter-

polate a value.

Adjust imported A values: This check box enables or

disables applying match data to imported A records. If

the above and below units were matched to each other

prior to data collection, you can leave this box

unchecked.
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“A in Dest / A in Source” puts the matching data (A

records) in the below file along with the normal B

records.

“B in Match / A in source” puts the matching data (B

records) in separate files.

“B / A pairs in Match” puts the A and B match data

together in one place, which might be useful for

archival purposes, and it means the program does not

have to find the A records as when using the files as

match files.

Mean and Interpolated Radio Buttons: This determines

whether the match data used to correct imported A

readings is a constant or interpolated. The best way to

determine this is to use the Preview button and com-

pare the Ratio vs. Time plot (shown below).

Preview this…: This button allows you to see in

advance what the adjustment values will be. The pre-

view dialog has three tabs: Summary, Details, and

Graphs.

The Summary tab shows what the adjustment factors

will be, whether using a mean or interpolating over

time.
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The Details tab shows all the pairs of A and B readings

that will be used for match data.

The Graph tab can show the match data plotted as a

function of sensor ring, or it can show match data plot-

ted as a function of time.
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The latter is helpful for determining whether match

data should be interpolated or not.
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Export Data in Spreadsheet

Format

When exporting data in spreadsheet format, you can

save the entire file or output a subset of the file.

1. Select the files that you wish to output (page 6-8).
2. Click File > Export… or click the Export button

on the toolbar.
3. In the “Export” dialog box, choose which LAI

files in the current view to include (All or Selected).

Then, select which variables you wish to include.

“Same as View” means the variables shown in the

view will be the one included. To select a different

group, click the “Other” radio button, then the

“Define…” button, and build the list by dragging

items from the master list (see Column Headings

on page 6-7). Click OK when you are finished defin-

ing the rows and columns.
4. The results are shown in plain text, each row tab

delimited. This can be copied to the system clip-

board and pasted into a spreadsheet and/or saved

to disk.
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FV2200 Tools
Saving a View

The files within a view can be saved by selecting the

saveAs button or File > saveAs….

There are two formats available for storing LAI files.

Most of the time, you will use the default LAI-2200

format. The LAI-2000 format may be useful if you want

to read the stored file with the older FV2000 software.

In either case, the resulting file is a text file. The only

difference is in the header information. Select “Retain

Format” to keep the original formatting of the file.
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Deleting Records

Records can be removed from an LAI file by selecting

Edit > Records > Remove from the Edit menu or

the Records Strip button.

Records can be removed based on type (A , B , etc.),

time stamp, or observation number. To get a summary

view of an LAI file’s records, use the As Read tab of

the File Details window.
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Transforming Records

The raw values of records can be mathematically mod-

ified. Click the Transform button, select a trans-

formation and enter the parameters.
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The Recompute Dialog Box

The recompute dialog box is used to specify three

major groups of settings:

1. What is the canopy shape (see Canopy Models,

page 6-24).
2. How is transmittance computed (see Computing

Transmittance, page 6-27).
3. Which rings are used (see Masking Rings, page 6-

29).

It can be accessed for multiple files from the Main Win-

dow toolbar (or Edit > Recompute) or for individual

files from the Header tab in the File Details window.
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Canopy Models

The LAI-2200 theory is based on measurements of gap

fraction at 5 zenith angles. The only other data that

needs to be supplied are the path lengths of view

through the canopy at those 5 angles. These path

lengths are the 5 values labeled DISTS in LAI-2200

files.

FV2200 supplies three canopy models (methods) as an

aid in determining the correct path lengths: Horizontal

is the default LAI-2200 setting. The basic assumption is

that all of the sensor’s rings see out the top of the flat

canopy.  Isolated Canopy, Measured Distances is for

canopies that are not sufficiently wide and flat, the

default path lengths may not be appropriate. Path

lengths are measured and entered.  Isolated Canopy,

Computed Distances is for canopies that are not suf-

ficiently wide and flat, path lengths are computed

based on measurements of the canopy profile.

Canopy model is an attribute of each LAI file in

FV2200. Model type can be displayed in a view (vari-

able: Model) and modified in the Recompute Dialog

box.
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Horizontal

Path length is a simple function (1/cosine) of the

zenith angle. Canopy height can be ignored – it cancels

out of the equation for LAI. If you wish to know

foliage density (foliage density/canopy volume), how-

ever, divide the reported LAI value by canopy height

(m).

Isolated Measured

The user measures and enters each path length. In this

case, the reported LAI value is foliage density (m 2

foliage area/m 3 canopy volume). Distance values

should be entered in units of m. Note: it is assumed that

the entered distances are appropriate for all azimuthal angles of

view (i.e., the canopy is round).
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Isolated Computed

Path lengths are computed based on a vertical profile of

the canopy, and where the sensor is in relation to it.

Azimuthal asymmetry is allowed, meaning that the can-

opy can be round or stretched out like a hedge. If the

canopy is asymmetric, then the average path length for

each ring will be a function of the view cap.

a
b

b/a = 1

a

b

b/a = 2

a

b

b/a = 10

If you specify a 

vertical profile 

where all the X 

values (from the 

“Change vertical 

profile” field) are 

>0, left-right sym-

metry is assumed. 

That is, the top 

view starts out 

round and 

stretches when you 

increase the row 

ratio.

a

b

a

b

a

b

b/a = 1 b/a = 2 b/a = 10

If you specify a vertical 

profile where some X 

values (from the “Change 

vertical profile” field) are 

<0 (X=0 is the plant 

stem), left-right symmetry 

is not assumed. For 

example, if the largest X 

value is 1 and the small-

est is -0.5, the top view 

will display the right half 

as a semicircle of radius 

1, and the left half will be 

an ellipse with X axis 0.5 

and Y axis 1.0.
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The vertical canopy can be adjusted in the Profile

Editor window (click Edit… under the Change Ver-

tical Profile check box). By default there are four points

(X,Z coordinates). To add a coordinate, right click on

the canopy shape and select Add point. The “Change

Row Ratio” field can range from 1.0 to 10.0 It is the

ratio of across-row (x) to in-row (y) dimensions of a

plant.

To see an example of an asymmetric row, go to File >

Sample files > Menu Example and open the file

called ROW2. In the Recompute dialog, set the row

ratio to 1. The right side of the canopy will have a hemi-

spherical radius and the left will have an ellipse.

Computing Transmittance

The method for computing transmittance is condensed

into a 3-character code, which indicates:

1. What is the relation between Above, Below, and A,

B records?
2. How to determine Above-canopy values?
3. What to do with bad readings?

FV2200 Description    Console

Code      Setting

First Character: Determine the role of A and B records

A__ (Default) A records are Above, B are Below  A

B__ B records are Above, A are Below   B

C__ Compare A & B to find which are above (largest values) Compare

Second Character: Determine the Above values

_P_ (Default) Use the previous record   Previous

_I_ Interpolate between the nearest (time) Above readings Interpolate

_C_ Use the closest in time Above reading  Closest

Third Character: When a Below record has a value > its 

corresponding Above value

__S (Default) Skip that record   Skip

__C Clip the transmittance (Below/Above) to be 1.0 for  Clip

 that ring

Thus, the method for computing transmittance is sum-

marized in a three-character code such as “AIC” or
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“CPS”. This code can be viewed for a file via the vari-

able Transcomp in the Main Window. When FV2200

stores a file in FV2200 format, these codes are in the

Transcomp line, just like the LAI-2200 console does it.

If you store a file in FV2000 format, the software tucks

the three letters after the LAI label. Also, the code for

“Compare” is represented with the letter F, and the

code for “Clip” is a T in files saved in FV2000 format.

The method used to compute the transmittance can be

changed in the Recompute Dialog box.
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Masking Rings

The LAI-2200 sensor has 5 concentric rings that make

up a field of view that extends from the zenith (0°) to

near the horizon (74°). Sometimes it is necessary to

reanalyze LAI-2200 data by neglecting (“masking”) cer-

tain rings. For example, if the field of view of the ref-

erence readings was not sufficiently wide, one or more

of the outer rings should be ignored. Also, if a plot of

contact number versus angle is not monotonic, as illus-

trated below, excess scattering is indicated, and the 5th

ring should be ignored.

The mask setting can be adjusted in the Recompute

Dialog box. See Excluding Rings from Analysis (page 6-

11) for a step-by-step example. 6
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Summary Statistics

Mean, range, and standard deviation are readily com-

puted on any numeric FV2200 variable.

1. Highlight the files to be included. If none are high-

lighted, all will be included.
2. Click the Statistics tool.
3. In the Generate Statistics dialog box, select the

variables to be included. They can be the same as

the Main Window or you can define a different set

(click on Define…).
4. Click OK . View the results, which are shown in a

window that can be printed or saved.
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File Details

This dialog, accessed by double-clicking an entry in the

Main Window, presents four views of the selected file.

As Read

This view shows the file in the form in which it is

stored on the disk. Data is not editable in this view.

Current

This shows an editable view of the file. Changes can be

made by selecting the numbers in a field and keying in

new values (e.g., masking rings). Click Cancel to undo

changes orKeep to save changes and view the results.
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All Values

The All Values view shows all of FV2200’s variables

(except raw data) for the file.

Header

The Header view shows a summary statistics table, stat-

istics graph, and the canopy model and mask. Any vari-

ables shown in the ring summary table can be displayed

in the graph by selecting the column of interest. Data

in the Header tab reflects changes that were imple-

mented in the Current tab. To change the canopy

model and mask for the selected file, click the

Change… button.
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Computing LAI

FV2200 duplicates the LAI computation done in the

LAI- 2200 console (LAI- 2000 Method), and also

provides some alternatives: the Lang Method, Ellips-

oidal Method, and Constrained Least Squares Method.

These are described below.

There are some points to remember when interpreting

these results:

1. The “L” in LAI (Leaf Area Index) is traditional, and

not necessarily a fact. Anything that blocks light

will be included in the result: branches, stems, anim-

als, etc. Thus, “Foliage Area Index” is a better way

to think of this.
2. LAI could be foliage area index (m 2

foliage/m2ground), or foliage area density (m2/m3)

canopy. It is the path lengths (Dist[*]) that determ-

ine which units are appropriate. For standard path

lengths (Horizontal Uniform model), LAI is foliage

area index. Forany other path lengths (Isolated Can-

opy, Measured Distances, and Isolated Canopy,

Computed Distances), LAI should be interpreted

as foliage density.
3. The LAI values include a correction (log average

transmittances) for clumping. Thus, especially if nar-

row view caps were used, measured LAI is closer

to L (true LAI) than Le (effective LAI). If you want

Le, multiply LAI by ACF, the apparent clumping

factor.
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LAI-2000 Method

LAI is computed from (see Chapter 9 Theory for the

derivation):

L K W= 2∑
i i i=1
5 6-1

where L is the leaf (all light blocking objects) area index

(LAI), K i is the mean contact number for the i
th ring

(contact#[*]), and Wi is the weighting factor for the ith

ring (LAI_W[*]).

The mean contact number is a function of the trans-

mittance and the path length S i (Dist [*]). For n

Above/Below pairs of observations,

K =i S

∑ −ln
n i

n
B j

A

i

1

=1











6-2

Weighting factorWi is computed from

W θ θ= ∆ sini i i
6-3

where θi is the mean zenith angle and θ∆ i is the ring

width (radians) associated with ith ring. Values for θ∆ i

are given in Table 6-1. Ring widths and weighting

factors. below. The weighting factors are normalized to

sum to 1.0, so when one or more rings are masked, the

remaining weighting factors increase.
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Table 6-1. Ring widthsand weighting factors.

Ring Width (°) Weighting Factor

1 12.2 0.041

2 12.2 0.131

3 11.8 0.201

4 13.2 0.290

5 13.2 0.337

Lang Method

A simple method of computing LAI from the slope

and intercept of a plot of contact number vs. angle was

proposed by Lang (1987).

L m b= 2( + )lang 6-4

where Llang is leaf area index (LangLAI), m is the slope

and b is the intercept of contact number (CNTCT#[*])

plotted as a function of angle (in radians). LangLAI can

be added to views or viewed in the “All Values” tab of

any data file.

Ellipsoidal Method

Another method of inverting gap fraction data is to use

an ellipsoidal- based description of leaf angle dis-

tribution. Refer to Norman and Campbell (1989), and

Campbell (1986).

Variables computed with the Ellipsoidal Method

include:

EllipLAI – LAI (or foliage density) obtained from the

ellipsoidal distribution method.
EllipMTA – Mean Tip Angle obtained from the ellips-

oidal method.
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EllipX – The ratio of horizontal to vertical radii of an

ellipsoid whose surface area fractions describe the

foliage angle distributions in the canopy.

These variables can be added to views or viewed in the

“All Values” tab of any data file.

Constrained Least Squares Method

An alternative method of inverting gap fraction data is

that of constrained least squares. Refer to Norman and

Campbell (1989) and Perry et al. (1988). The outputs

associated with this method are listed below:

CLS_LAI – LAI (or foliage density) by method of the

constrained least squares.
CLS_c – The smallest constraint that yields all positive

area fractions.
CLS_LAD[*] – foliage angle distribution. The angle

classes are 9°, 27°, 45°, 63°, and 81° (90 divided

evenly by 5). If one or more rings are masked, there

will be fewer angle classes.
CLS_MTA – Mean Tip Angle based on the dis-

tribution (S).
CLS_Mu, CLS_Nu – Mu, Nu of the Beta distribution

(Goel and Strebel, 1984).
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Graphical Analysis
Any data within an LAI-2200 file, or across multiple

files in a view, can be plotted. Select the file (s) to be

included, and click on the Add Chart button, or click

View > Add Chart…. Charts will open in a separate

window when they are created, but they can be added

to the Main Window by dragging and dropping the

chart into the window.

Here is a simple example that plots LAI as a function of

time in a sample file.

1. Open File > Sample Files > Manual Examples.
2. Click the Add Chart button.
3. Click the Favorites, Select “LAI History: LAI vs.

Date”.
4. Click OK.
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This example below describes in detail how you can

make the same plot with your own data.

1. Select a file that has data that you would like to

chart (the sample file LAI-2200_sample.txt under

File> Sample Files will suffice. Open the file,

select LAI_File 1, then click the Expand button.

Click on OK and select a file from the new list).
2. Click the Add Chart button, set the parameters as

shown below, and click the OK button.

The resulting chart will appear in a new window.

Only one file was selected, so only one point

appears in the plot. If you had selected all the files,

or chosen “All” under the “LAI Files:” menu, val-

ues for all files would appear in the chart.

3. Click through the list of files to change the selected

file. Select a range of files with Shift+Click or select

multiple files with Ctrl+Click (PC) or ⌘ +Click

(Mac). Notice how the chart updates when dif-

ferent files are selected.
4. Double click anywhere in the chart to bring back

the configuration dialog box, and make the fol-

lowing changes:
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5. Click OK. The chart will be redrawn using all the

files in the view, regardless of what is selected.

Note the addition of the 2nd variable on the right

axis, the legend, and a title.
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Chart Definition Dialog Box

Individual charts are defined using the dialog box

shown below, accessed by clicking the Add Chart but-

ton or double clicking an existing chart.

Selecting Variables

Variables for plotting are selected from the three-part

list box shown below. 61 variables are available to

choose from. These variables can be grouped into

three categories: Standard, Ring, and Raw.

Standard variables are single-valued variables. Ring val-

ues are 5-valued (one for each ring) summaries. Raw

measurements are the observations (A and B).
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Description of Variables

Items in the list below are variables output from the

LAI-2200. Items marked with * are unique to FV2200.

Header Items
LAI_File - LAI file name (Numeric for LAI- 2000,

alpha-numeric for LAI-2200).
Version - Software version (defined for LAI-2200 only)
Date - Timestamp in the file header. For LAI-2000,

year defaults to 2000.
RawStart* - Starting time for the raw data
RawStop* - Ending time for the raw data
Prompt1
Prompt2
Resp1
Resp2
A-B-?-1-2* - Number of each record type. '?' defined

only in LAI-2000
#A* Number of A records
#B* Number of B records
#1* Number of 1 (light sensor) records
#2* Number of 2 (light sensor) records
#?* - Number of '?' records
Transcomp - 3 character code for how transmittance is

computed
Model - Canopy model:
Horizontal (The default. Distances are 1/cos).
IsoFixed (Isolated canopy, fixed distances, user

entered).
'IsoComputed (Isolated canopy, distances computed

from vertical and horizontal profiles).

<items specific to IsoFixed / IsoCompted >

ViewCap* - Size (degrees open) and direction (0 = +x

direction)
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SensorPosX* - Sensor position in X direction (across

row)
SensorPosZ* - Sensor position in Z direction (ver-

tical)
RowRatio* - Ratio canopy Y to X direction (Y = along

row, X = cross row). 1 = round canopy
Volume* - Computed canopy volume (in view of

sensor)
Area* - Drip line area (in view of sensor)
DLLAI*- Drip line LAI = foliage density * Volume /

Area
ViewCap* - Size of opening of view cap
ViewDir* - Direction of view, relative to row, 0=cross

row
LAI - Leaf Area Index (or Foliage Density if canopy

model is not Horizontal).
SEL - Standard error of LAI
ACF - Apparent clumping factor for LAI
DIFN - Diffuse non-interceptance
DIFN_Sky* - Diffuse non-interceptance weighted for

the measured sky brightness distribution
MTA - Mean tip angle, degrees
SEM - Estimate of standard error of mean tip angle
SMP - Number of Above/Below pairs used to com-

pute LAI
LangLAI - LAI using Lang method
EllipLAI* - LAI using Campbell method of elliptical

foliage angle distribution
EllipX* - 'X' factor for the elliptical angle distribution

(ratio of radii)
EllipMTA* - Mean tip angle from elliptical method
ClsLAI* - LAI determined from constrained least

squares method (CLS)
ClsMTA* - Mean tip angle from CLS
Cls_mu* - mu parameter for beta distribution of

foliage angle from CLS
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Cls_nu* - nu parameter for beta distribution of foliage

angle from CLS
Cls_c* - final CLS constraint factor
Mask* - 5 values of 1 or 0 for rings 1 to 5, indicating if

the ring was used or ignored.

11111 - all used

11110 - ring 5 ignored

Ring Related Items
Angles - The angle values for each ring
ACFs - Apparent clumping factor for each ring

p θ p θln ( ) / ln ( )

AvgTrans - Average transmittance for each ring
CNTCT# - Contact number (average of the log of the

individual transmittances divided by distance)
STDDEV - Standard deviation of the contact numbers
DISTS - Canopy path length for each ring
GAPS - Gap fraction based on average of the log of the

individual transmittances
LAI_Wt - Weighting factors for Contact numbers

when computing LAI
DIFN_Wt - Weighting factors for Gaps when com-

puting DIFN
ClsLAD - Leaf angle distribution from CLS inversion
MeanA - Mean of the A readings, ring by ring

MeanB - Mean of the B readings, ring by ring
MaxA - Max value of the A readings, ring by ring
MaxB - Max value of the B readings, ring by ring
MinA - Min value of the A readings, ring by ring
MinB - Min value of the B readings, ring by ring

Raw Readings
RawTime - Time stamp for the raw record
RawA - A record, with 5 ring values
RawB - B record, with 5 ring values
Raw1 - 1 type record
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Raw2 - 2 type record

Grouping Options

Data can be displayed in groups by selecting File or

Ring.

Group by File will give each file a distinct symbol. Plot-

ting 10 files will result in 10 symbols, and 10 items in

the legend. If the plot has both left and right axes,

there will be 20 symbols (and 20 legend entries). When

graphing a large number of files, you may wish to not

use this option, or turn off the legend.

Group by Ring applies to variables that have a separate

value for each ring. Values for each ring are assigned a

symbol.  When grouped by ring, there will be 5 sym-

bols - one for each ring. If a ring variable is plotted on

both dependent axes, there will be 10 symbols in the

legend.

Chart Context Menu

Right-clicking on a chart will bring up the context

menu:

Edit… – Brings up the Chart Setup dialog.
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Auto-update – Enable/disable the auto update feature

of the chart.
Data Source – Has a submenu of all the current views.

Pick the one to use with this plot.
Page Setup… – Provides page setup parameters for

the selected plot.
Print… – Send the chart to a printer.
Capture… – Save the chart as a .pdf file.
Remove this Chart – Deletes the chart.
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7 Tutorials and
Examples

This section serves as a guide for two advanced topics:

collecting and processing data isolated canopies and

practical strategies for multi-sensor operation. Six com-

plete examples are given below, and each has a cor-

responding data file in FV2200 software Menu

Examples (see the Sample files).

A Simple Isolated Canopy
Consider the example given on page 5-13 . In this

example, the plant is a hemispherical shrub with meas-

ured path lengths of 0.7 m. Launch the FV2200 soft-

ware. Click on File > Sample files > Manual

Examples.txt. Double click on the file called SHRUB

to view file details, then select the “As Read” tab.  The

data file for this shrub looks something like this:
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... 

MODEL IsoMeasured

...

LAI  6.69 

SEL  0.00

ACF  1.000

DIFN  0.092

MTA  49

SEM  2

SMP  1

MASK  1 1 1 1 1

ANGLES 7.00 23.00 38.00 53.00 68.00

AVGTRANS 0.059 0.068 0.097 0.084 0.131

ACFS  1.000 1.000 1.000 1.000 1.000

CNTCT# 4.035 3.850 3.338 3.539 2.903

STDDEV 0.000 0.000 0.000 0.000 0.000

DISTS  0.700 0.700 0.700 0.700 0.700

GAPS  0.059 0.068 0.097 0.084 0.131

...

A: 1 20090924 12:13:44  109.23  108.96  102.21  96.61  100.67

B: 2  20090924 12:14:05  6.480    7.360    9.880    8.110  13.19

The LAI value is foliage density. There are two ways to

tell this by looking at the file. One is the “Model” line.

“Horizontal” means the canopy model is horizontally

infinite, or at least large enough that the default DISTS

vectors apply. “IsoMeasured” means an isolated can-

opy. The other way to know this is to look at the

DISTS values. Since they are not the default values

(1.008, 1.086, 1.269, 1.662, and 2.669), then LAI should

be interpreted as foliage density.

Click on the “Header” tab, then click “Change…”. In

the Recompute dialog, check Change Canopy Model,

then check Change View Cap. Select the 90 degree

cap and observe changes in the Volume and Area

fields, which are used to compute Drip Line LAI

(DLLAI).
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Isolated Tree
Below is an example of the procedure that could be

used to measure LAI for an isolated plant. The steps

below will generate a file much like the example file

maned TREE1 in the FV2200 software, which is

accessed by going to File > Sample files > Manual

Examples.

1. Create a new file with default Transcomp settings.

Use a 90° view cap and take one AB pair in each of

the four directions.
2. Measure the average shape of the tree’s crown with

several X, Z pairs of points that describe the pro-

file, as shown below (a photo of the profile with a

meter stick for scale could be used as well).
3. Measure the X and Z offsets, as shown below.

1 2
3

4

5

6

7

    X      Z

1: (0.0, 0.6)

2: (0.8, 0.6)

3: (1.4, 0.8)

4: (1.6, 1.5)

5: (1.3, 2.3)

6: (0.8, 2.8)

7: (0.0, 3.5)

X

Z

Measure the distance 

between the sensor 

and the bottom of the 

canopy (Z offset), 

0.5 m in this case.

Measure the distance between the sensor and the 

centerline of the canopy (X offset), 0.05 m in this case.

Place the 

sensor at 

ground level 

for B readings
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4. Open the file with the FV2200 software.
5. Select the file and click the Recompute button.

Check the Change Canopy Model box.
6. Check the Isolated Computed box, and the

Change vertical profile box.
7. Click the Edit…button and enter the X, Z coordin-

ates to define the canopy shape. Right click on the

profile to add more points. Click OK when fin-

ished.
8. Enter the X and Z sensor position. Observe

changes in volume and area values as these fields

are updated.
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9. ClickOK to implement the changes. The new LAI

value, along with a summary of the procedure, will

be visible in the log.
10. Save the file to retain any changes.
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Isolated Row 1
There are two approaches that can be used to measure

an isolated row, such as a grape vine or hedge. The first

is described here, and the second is described in

example 2 below.

The steps below will generate a file much like the

example named ROW1 in the FV2200 software, which

is opened by File > Sample files > Manual

Examples.

1. Set the console Transcomp settings to Define

Above: A; Determine Above: Interpolate; Bad

Readings: Clip. Place a view cap with a 90° opening

over the lens and create a new file.

Below

Above

Above

Y

X

2. Make an above- canopy

reading, multiple below-

canopy readings, and a

second above- canopy

reading. Make the below

canopy readings with

the sensor at the base of

the canopy, as shown.
3. Measure several X, Z

coordinates (meters) to

characterize the vertical

profile, perpendicular to

the centerline of the

hedge. This example

uses 8 coordinates. See

the figure below.
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1

2 3
4

5

    X        Z

1: (0.0,   0.0)

2: (0.0,   1.47)

3: (0.31, 1.39)

4: (0.51, 1.27)

5: (0.67, 1.05)

6: (0.63, 0.79)

7: (0.54, 0.51)

8: (0.25, 0.14)

6

7

8

X

ZPlace the 

sensor at the 

0,0 coordinate.

4. Measure the width (Y) and depth (X) of the hedge

to compute the row ratio (Y/X), 5 in this case.
5. Open the data file in the FV2200 software.
6. Click the Recompute button. In the Recompute

Dialog box, select Change Mask . Deselect ring 5

because it did not “view” any foliage.
7. Next, check the Change Canopy Model check

box, then the Isolated Computed radio button.

Check the Change vertical profile button, then

select Edit….
8. Enter the X, Z coordinates to define the shape of

the hedge. Right click on the canopy profile to add

more points.
9. Check the Change Row Ratio box and set the row

ratio to 5. ClickOK.
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10. The new LAI values are displayed in the Log. Save

the file to retain changes.

If the hedge were asymmetrical, two files would be

required, one for each side of the canopy  (or example

2 below could be used).
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Isolated Row 2
The steps below will create a file similar to the example

ROW2 in the FV2200 software, which is opened by

File > Sample files > Manual Examples.

1. Set the console Transcomp settings to Define

Above: A; Determine Above: Interpolate; Bad

Readings: Clip. Place a view cap with a 90° opening

over the lens and create a new file.

Above

Above

Below

Y
X

2. Make an above-canopy

reading, several below

canopy readings, and a

final above-canopy read-

ing. Take the below-can-

opy readings along a

line that is parallel to

the centerline of the

shrub, but not directly

under the shrub, as

shown.
3. Measure a number of X,

Z coordinates (meters)

to characterize the ver-

tical profile, per-

pendicular to the

centerline, of the

hedge. Measure the dis-

tance between where

the B readings were taken and the centerline of

the hedge (X offset), -0.20 in this case, and the dis-

tance between the vegetation and the sensor (Z

offset) in meters (0.0 in this case), as shown in the

figure below.
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12

3

4

5

    X         Z

1: (0.0,    0.0)

2: (-0.12, 0.25)

3: (-0.18, 0.59)

4: (-0.23, 0.94)

5: (-0.17, 1.27)

6: (0.0,    1.47)

7: (0.3,    1.39)

8: (0.51,  1.56)

9: (0.66,  1.04)

10: (0.63, 0.78)

11: (0.53, 0.51)

12: (0.24, 0.14)

6
7

8

9

10

11

12

X

Z

Make B readings 

with the sensor at 

the base of the 

vegetation or 

below the canopy. 

Measure the X 

and Z offsets from 

coordinate #1. In 

this case, they are 

-0.20, 0.0.

4. Measure the width (Y) and depth (X) of the hedge

to compute the row ratio (Y/X).
5. Open the data file in the FV2200 software.
6. Click the Recompute button. In the Recompute

Dialog box, check the Change Canopy Model

check box, then the Isolated Computed radio but-

ton. Check the Change vertical profile button,

then select Edit….
7. Enter the X, Z coordinates to define the shape of

the hedge. Right click on the canopy profile to add

more points.
8. Check the Change Sensor check box.
9. Check the Change Row Ratio box and set the

ratio. ClickOK.
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The new LAI value is shown in the Log. Save the file

to retain changes.
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Practical Strategies for Multi-
Sensor Operation
When using two sensors to collect data for a single pro-

ject, both sensors must be matched. That is, one

sensor is adjusted so that both read the same under the

same conditions. As a practical matter, however, this

can be problematic. For example:

l Using an LAI-2200 with an LAI-2000
l Using multiple below canopy sensors
l Matching may be a function of time-of-day

Below are two simple strategies that solve all of these

problems. To summarize both: don’t worry about

matching the sensors in the field; rather, simply collect

a little extra data that can be used later to match the

readings. This is made easier using FV2200 (version 1.2

and above), which will use this data and automatically

combine the steps of matching sensors and importing

A records.

Method #1: Match Data Embed-

ded in the Below File

Use this method if it is convenient to start and stop

each below canopy file at the location of the A unit.

1. (A unit) Set up the above canopy unit in a suitable

location, and start logging above readings to the

unit. If using both an LAI-2000 and LAI-2200, use

the LAI-2000 to collect the A readings.
2. (B unit) Create a new file for the first below canopy

transect.
3. (B unit) Use the button on the wand to set the read-

ing to A and log 2 or 3 A readings with the below
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sensor level and side-by-side with the A sensor,

viewing the exact same region of the sky.
4. (B unit) Toggle the readings to B , and collect all

the below-readings for the first transect.
5. (B unit) When finished with the transect, return to

the A unit and repeat step 3. Then close the file.
6. Repeat steps 2 through 5 for the remaining tran-

sects.

A sample data set created using this method is in

FV2200 (File>SampleFiles>ImportExample-1).

Data Processing for Method #1

1. Load the above and below files into FV2200. They

can be in the same or separate views.
2. Click the Import Records button and set the dialog

box as shown below, with appropriate files checked

for source (A readings) and destination (B read-

ings).
3. When you click OK, A records will be imported

from the file(s) marked as Source and inserted before

each B record in the files marked as Dest. In addi-

tion, the imported A readings will be adjusted

according to the matching data you have indicated.
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Method #2: Match Data in Separ-

ate Files

Use this method if it is not convenient to return to the

A sensor between below canopy transects.

1. (A unit) Set up the above-canopy unit in a suitable

location and start automatic data logging on the

unit. If using both an LAI-2000 and an LAI-2200,

use the LAI-2000 to collect these readings. If using

multiple LAI-2200s use a detached wand for these

readings.
2. (B unit) Before leaving the A sensor location, cre-

ate a new file (name it M1, M2, etc., or MCH1,

MCH2, etc., to indicate that this is the Match file)

and log 2 or 3 readings in it, with the sensor side-

by-side with the A unit sensor, and viewing the

exact same region of sky. Close the match file.

A sample data set created using this method is in

FV2200 (File>SampleFiles>ImportExample-2).

Data Processing for Method #2

1. Load the above, below, and match files into

FV2200. They can be in the same or separate views.
2. Click the Import Records button and set the dialog

as shown below.
3. When you click OK, A records will be imported

from the file(s) marked as source and inserted before

each B record in the files marked as dest. In addi-

tion, the imported records will be adjusted accord-

ing to the matching data you have indicated.
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8 Instrument Software
Reference

This section provides a description of the functions

that are available through the LAI-2200 Control Unit

software.

Main Menu
1 Wand Setup

Select Wand X (name) or Y (name)

1.1 Set Name

These fields are used to name the optical sensors.

When an optical sensor is named, the name is stored in

the optical sensor. For example, if an optical sensor is

attached to the X port and named “PCH3102”, and

later attached to the Y port, it will still be called

“PCH3102”.

1.2 Clock

1.2.1 Set

The Set function is used to manually enter the time for

the optical sensor clocks (HH:MM, YYYY/MM/DD).

1.2.2 Sync

The Sync function sets the optical sensor clock based

on the control unit clock. Presents Yes/No veri-

fication.
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1.3 Cal Values

Calibration multipliers are set from this field. Use the

arrow and numeric keys to enter calibration values.

Press OK to store the values. These values should

match the calibration sheet.

1.4 Match Values

These functions pertain to the match values for the

selected wand.

1.4.1 View / Set Values

View/Set allows you to view and/or edit the current

values, or reset them to the calibration values by press-

ing LOG.

1.4.2 Compute Values

Two wands must be connected for this. The wand

selected when entering the menu will be matched to

the other. Compute will determine the values by meas-

urement: You will need a second wand connected to

do this, and both wands positioned and stable, viewing

the same view of the sky (Don't do this indoors with

artificial light, or looking out a window - tiny variations

in views can cause large errors in those environments.)

When you select "Yes", the match will be performed.

1.5 Auto Log

1.5.1 On/Off

1.5.2 Start Time

1.5.3 Stop Time

1.5.4 Frequency

Auto Log and the subsequent menu options are used

to configure automatic logging, start time, stop time,
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and frequency.

2 Log Setup

These settings apply to new data, not existing data.

2.1 Transcomp

2.1.1 Define above:

This field defines how the sensor determines which

readings are above-canopy and which are below- can-

opy.

Compare: The console will compare adjacent records

to determine which type (A or B) has consistently

higher values for active (non-masked) rings. That type

will then be considered the above-canopy record type.

A: Means that readings taken while the optical sensor

“Above” LED is illuminated will be considered above-

canopy readings when calculating LAI.

B: Readings taken while the optical sensor “Above”

LED is not illuminated will be considered below-can-

opy readings when calculating LAI.

2.1.2 Determine Above:

This field defines how the sensor uses above-canopy

readings when computing LAI.

Previous: Uses the previous above-canopy record in

the file to compute LAI.

Interpolate: Interpolates between two closest-in-time

above-canopy records to generate each required above-

canopy record. This is particularly useful when sky con-

ditions are changing rapidly.
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Closest:Associates each above-canopy record with the

closest below-canopy record (in time) to compute

LAI.

2.1.3 Bad Readings:

Bad readings occur when a below reading exceeds the

value of a corresponding above reading (see page 4-7).

There are two options:

Skip: The instrument will beep if a below reading has

transmittance >1.0. It will log the below reading, but it

will not use the record when computing LAI.

Clip: The transmittance for that ring in that record will

be taken to be 1.0 when LAI is computed.

2.2 Prompts

Prompt1:
Resp1:
Prompt2:
Resp2:

Set prompts to prompt the user for additional inform-

ation that will be recorded with each data file.

2.3 Obs Remarks

Remarks can be entered for each logged record.

Remarks are set at this menu level or changed for indi-

vidual records by entering the Log Setup menu while

in logging mode. Changes to the remark are saved with

each subsequent data file.

2.4 Angles

2.4.1 Sensor Angles:
1: 7.00
2: 23.00
3: 38.00
4: 53.00
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5: 68.00

Angles in these fields are set to reflect the view of each

ring in the sensor.

2.5 Distances

2.5.1 Distance Vectors
1: 1.008
2: 1.087
3: 1.270
4: 1.662
5: 2.670

The values are the average path length each rings sees

through the canopy. By default, the values are 1/cosΘ.
For large, flat uniform canopies, this is sufficient; can-

opy height does not matter. For isolated canopies, the

values should represent actual path lengths in meters.

2.6 Masks

2.6.1 Use Ring
Ring1: <YES | NO>
Ring2: <YES | NO>
Ring3: <YES | NO>
Ring4: <YES | NO>
Ring5: <YES | NO>

Determines which rings are used in LAI calculations.

To exclude a ring, set its value (use ← and →) to No.

To reset (all rings to Yes), press the Log button while

viewing this screen.

2.7 Controlled Sequence

Use: Yes|No
Reps: up to 41
Pattern:
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2.8 PAR Sensors

2.8.1 Port 1

2.8.2 Port 2
Enabled: < On | Off >
Name: Port 1
Cal: xxxxx

These fields are used to configure LI-COR Biosciences

radiation sensors. Enable the port by selecting On,

Name the sensor, and enter the calibration multiplier

for the sensor.

3 Data

3.1 Console Data

3.1.1 Select data file:

3.1.1.1 Quick View

Shows the file header, which includes the file name,

time and date created, responses to prompts, LAI,

SEL, ACF, MTA, SEM, DIFN, and SMP (sample size).

3.1.1.2 View

3.1.1.2.1 View Header

Shows file name, time and date created, responses to

prompts, LAI, SEL, ACF, MTA, SEM, DIFN, and SMP

(sample size).

3.1.1.2.2 View ANGLES/MASK

Shows angles and masks used to compute the selected

data file.

3.1.1.2.3 View CNTCT #/STDDEV

Shows contact number and standard deviation com-

puted for the selected data file.
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3.1.1.2.4 View AVGTRANS/GAPS

Shows average transmittance and gap fraction com-

puted for the selected data file.

3.1.1.2.5 View DISTS/ACFS

Shows distances and apparent clumping factors for

each ring.

3.1.1.2.6 View Observations

Shows ring values for each above and below reading in

the file. Use the left/right arrow keys to scroll through

readings.

3.1.1.3 Edit

These options pertain to the selected data file only.

3.1.1.3.1 Edit Angles

Sensor Angles: Edit the angles used in computations.

Press OK to save new settings, EXIT to cancel, and

LOG to reset to default settings.

3.1.1.3.2 Edit Mask

Use Mask: Apply a mask to any ring that is not to be

used in computations. Press OK to save the new set-

tings, EXIT to cancel, and LOG to reset to default val-

ues.

3.1.1.3.3 Edit Distances

Distance Vectors: Change these values to alter dis-

tances used in computations. Press OK to save the

new settings, EXIT to cancel, and LOG to reset to

default values.

3.1.1.3.4 Edit Transcomp
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Use this field to change how the instrument defines

above-canopy readings, determines above-canopy read-

ings, and treats bad readings. A full description is in sec-

tion 2.1 above.

3.1.1.3.5 Import Observations

This function can be used to import A or B records

from another file.

3.1.1.3.6 Strip Observations

This function can be used to remove all A orB records

from a file.

3.1.1.4 Recompute

Recomputes values for the selected data file. Use

recomputed if any changes have been made to the file.

3.1.1.5 Delete

Permanently deletes the selected file.

3.1.1.5 Rename

Prompts for a new file name for the selected file.

3.2 Wand Data

3.2.1 Download – to transfer data from the

wand to the control unit.

3.2.2 Purge – to delete data files from the

wand.
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4 Console Setup

4.1 Set Time

4.1.1 Console Time

Prompts for time and date. Use the up and down arrow

keys set time and date.

4.2 Auto Off Timer

Set the duration that the control unit will remain “On”

before powering off automatically. The auto off timer

can be set to 5-60 minutes in increments of 5 minutes

using the up/down arrow keys.

4.3 Beeper

Turns the instrument beeper “On/Off”. Select the

desired setting and pressOK.

5 Firmware

5.1 Console

5.1.1 Info

5.1.2 Upgrade

See page 10-2 for details.

5.2 Wand

5.2.1 Info

5.2.2 Upgrade

See page 10-2 for details.
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9 Theory
The LAI-2200 measures the probability of seeing the

sky when looking up through a vegetative canopy in dif-

ferent directions. These measurements essentially con-

tain two pieces of structural information about the

canopy: 1) the amount of foliage in the canopy and 2)

the foliage orientation. This section describes the

details of how the LAI-2200 extracts this information

from its measurements.

Calculations
As a beam of light passes through a plant canopy, there

is a certain probability that it will be intercepted by

foliage. The probability of interception is proportional

to the path length, foliage density (area of foliage per

volume of canopy), and foliage orientation. If foliage

elements are small compared to the overall canopy, and

they are randomly distributed in the sensor view, then

it is well known that a beam of light from zenith angle θ

has a probability of P(θ) of non-interception:

( )P θ e=
G θ µS θ− ( ) ( )

9-1

where G(θ) is the fraction of foliage projected toward θ,
µ is foliage density (m2 foliage per m3 canopy volume),
and S(θ) is path length (m) through the canopy at angle
θ. Miller (1967) gives the exact solution for µ as

∫µ θ d θ= 2 sin̟ P θ

S θ0
/2 ln ( )

( ) 9-2
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Foliage Density and Leaf Area

Index

In a horizontally large, homogeneous canopy, path

length, S(θ) is related to canopy height h by

S θ( ) =
h

θcos
9-3

In such a canopy, the relation between leaf area index

L and foliaged density µ is
L µh= 9-4

Substituting these into (9-2) yields

∫µ P θ θ θdθ= −ln ( )cos sin
h

µ2

0

/2

∫L µh P θ θ θdθ= = 2 −ln ( )cos sin
̟

0

/2

9-5

Thus, we can use a common formula (9-2) for com-

puting either L or μ: For L, we use S(θ)=1/cosθ (height

h does not matter because it cancels out of (9-5)), and

for computing μ we use actual values of S (θ ). The dif-

ference between L and μ is driven by S(θ).
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Clumping

When multiple observations of P(θ) are available, there

are two ways they could be combined: The values of P

(θ) could be averaged:

∫µ
P θ

S θ
θdθ= 2 −

ln ( )

( )
sin

̟

0

/2

9-6

or the values of lnP(θ) averaged:

∫µ
P θ

S θ
θdθ= 2 −

ln ( )

( )
sin

̟

0

/2

9-7

Eqn. (9-7) will account for clumping (on spatial scales

larger than the field of view of the sensor), but Eqn. (9-

6) is appropriate for determining effective leaf area

index Le, which by definition must ignore clumping.

The LAI-2200 computes both of these, and uses Eqn.

(9-7) for its reported leaf area index value L, and the

ratio of (9-6) and (9-7) for computing Ωapp, the apparent

clumping factor (Ryu et al. 2010).

∫

∫
Ω

P θ

S θ
θdθ

P θ

S θ
θdθ

=

2 −
ln ( )

( )
sin

2 −
ln ( )

( )
sin

app

̟

̟

0

/2

0

/2

9-8

Effective leaf area index, Le, can be computed by

L LΩ=e app 9-9
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Foliage Orientation

Once L or µ is determined from Eqn. (9-1), Eqn. (9-2)

can be solved for the orientation function G(θ).

G θ
P θ

µS θ
( ) =

−ln ( )

( ) 9-10

Figure 9-1 shows the theoretical values of G(θ) for an
ideal canopy whose foliage is random both in position

and azimuthal orientation, but inclined at a fixed angle.

Curves for ten different foliage inclination angles are

shown.
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Figure 9-1. Idealized relationship between projected foliage
area and direction for various foliage inclination angels, after
WarrenWilson (1959).

The LAI-2200 calculates foliage mean tilt angle αf after
the manner of Lang (1986), using an empirical poly-

nomial relating inclination angle to the slopes of the
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idealized curves between 25° and 65° (data in table 9-1,

plot in Figure 9-2).

Table 9-1.

MTA

(degrees)
Slope

MTA

(degrees)
Slope

1 -.6964 50 -.1547

10 -.6859 60 .1180

20 -.6546 70 .3164

30 -.5855 80 .4131

40 -.4105 89 .4431
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Figure 9-2. Plot of equation 9-22, which relates slope of the
foliage orientation function to average inclination angle. 0° leaf
angle is horizontal, and 90° is vertical.
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Implementation Algorithms

In this section, the subscript i refers to optical sensor

rings ( i=1…5), and the subscript j refers to obser-

vational pairs (j=1…Nobs). Bij is the jth below-canopy

observation, ith ring, and A ij is its corresponding above

canopy reading.

AVGTRANS

The average probability of light penetration into the

canopy is computed by

∑P θ
N

B

A
( ) =

1
i

obs j

N
ij

ij=1

obs

9-11

The 5 values of P θ( )i are labeled AVGTRANS in the

LAI-2200 data file.

GAPS

The probability of light penetration based on averaging

the logarithms of transmittance for the i th ring is com-

puted from

( )
∑

G e e= =i
P θ N

B

Aln ( )

1
ln

i obs j

N obs ij

ij=1













 9-12

The values ofGi are labeled GAPS in the data file.
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LAI and CNTCT#

The leaf area index L for the file, labeled LAI, is com-

puted from

∫ ∑L
P θ

S θ
θdθ K W= 2 −

ln ( )

( )
sin = 2

̟

i

i i
0

/2

=1

5

9-13

where

∑K
N S

=
1

−ln

i
obs j

N

B

A

i=1

obs

ij

ij











9-14

and

W θ dθ= sini i i
9-15

Ki is sometimes called the contact number, and is repor-

ted with the label CNTCT# in the data file. For further

explanation ofWi, see Weighting Factors, below.

ACF and ACFS

An apparent clumping factor for each ring, labeled

ACFS in the LAI-2200 data file, is computed from

∑

∑

Ω
P θ

P θ

B

A

B

A

=
ln ( )

ln ( )
=

ln

ln

i
i

i

N
j

N
ij

ij

N
j

N
ij

ij

1

=1

1

=1

obs

obs

obs

obs
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A total apparent clumping factor, Ωapp, labeled ACF in

the data file, is computed from
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∫

∫

∑

∑
Ω

P θ

S θ
θdθ

P θ

S θ
θdθ

P θ

S

K

=
2 −

ln ( )

( )
sin

2 −
ln ( )

( )
sin

=

2 −
ln ( )

2
app

̟

̟

i

i

i
i

i

i i

0

/2

0

/2

=1

5

=1

5

9-17

SEL and STDDEV

Standard error Lse of the leaf area index value is repor-

ted as SEL, and is computed from

∑

L

L L

N
=

−

se

N
j

N

j

obs

1

=1

2 2

obs

obs

9-18

where Lj is the leaf area index calculated for an indi-

vidual A/B pair

∑L K W= 2j

i

ij i

=1

5

9-19

where Kij is the contact value for the pair.

K
S

=

−ln

ij

B

A

i

ij

ij
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The standard deviation Kσi of the contact numbers is

reported as STDEV, and computed from

( )∑K
N

K K=
1

− 1
−σi

ob j

N

ij i

=1

2ob�

9-21

MTA

Mean Tip Angle α f is the average inclination of the

foliage in degrees from the horizontal (0=flat, 90=ve-
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rtical), and is computed from a 5th order polynomial α
(m) (see figure 9-2):

α m m m m m m( ) = + ( + ( + ( + ( + ) ) ) )0 1 2 3 4 5

9-22

where

a0=56.81964
a1=46.84833
a2=-64.62133
a3=-158.69141
a4=522.06260
a5=1008.14931

The value of α(m) is constrained so that 0 ≤α(m) ≤ 90.
The independent variable m is the slope of the mean

contact numbers (K) plotted against ring angle θ in radi-
ans.

( )α α
m

L
=f 9-23

SEM

Standard error of the mean tip angle is estimated from

α α α
m m

L
= −

±

se f
se







 9-24

where mse is the standard error of the slope m. When m

> 0, we use (m-mse); otherwise, we use (m+mse).

DIFN

Diffuse non-interceptance D is the fraction of sky radi-

ation that will penetrate the canopy, averaged over the

hemisphere (Norman and Welles, 1983). Note: this is

computed from P θln ( ) not P θln ( ) .
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∫
∫

∑D

G θ θ θdθ

θ θdθ

G W=
( )sin cos

sin cos
= 2 ′

̟

̟

i

i i

0

/2

0

/2
=1

5

9-25

whereW’i

W θ θ dθ′ = sin cosi i i i
9-26

This value is reported as DIFN in the data file. The

FV2200 makes a related computation (D sky , labeled

DIFN_SKY), that is weighted by sky brightness dis-

tribution based on the A readings.

∫
∫

∑

∑
D

A θ G θ θ θdθ

A θ θ θdθ

A G W

A W

=
( ) ( )sin cos

( )sin cos
=

′

′
sky

̟

̟

i

i i i

i

i i

0

/2

0

/2
=1

5

=1

5

9-27

where is the average of the NA above canopy readings

in the file.

∑A
N

A=
1

i
A j

N

ij

=1

A

9-28

Weighting Factors

The weighting factors for LAI and DIFN work out to

be (when no rings are masked)

θi dθi
Wi

sinθdθ

W'i
sinθcosθdθ

7 12.2 0.041 0.033

23 12.2 0.131 0.097

38 11.8 0.201 0.127

53 13.2 0.290 0.141

68 13.2 0.337 0.102
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When a ring is masked (excluded from the com-

putations), its weighting value is set to 0. This will

increase the weighting of the remaining rings, since

their sum must be

∫∑W θdθ= sin = 1
i

i

̟

=1

5

0

/2

9-29

and

∫∑W θ θdθ′ = sin cos = 0.5
i

i

̟

=1

5

0

/2

9-30

The values of W i are available on the FV2200 as the

LAI_wt, and the values ofW’i are shown as DIFN_wt.

Alternative Methods
Gap fractions have been measured using fisheye pho-

tographs (Anderson, 1971; Bonhomme and Chartier

1972), by traversing a sunward-pointed sensor beneath

the canopy (reviewed by Ross, 1981; Lang et al. 1985;

Perry et al. 1988), by linear light sensors (Walker et al.

1988), and by pushing metal probes through the can-

opy (Warren Wilson, 1959).

See Norman and Campbell (1989), Welles (1990),

Welles and Cohen (1996), Gower et al. (1999), Machado

and Reich (1999), de Jesus et al. (2001), Mussche et al.

(2001), Breda (2003) Hyer and Goertz (2004), Keane et

al. (2005), Garrigues et al. (2008) for additional reviews

and comparisons.

Mathematical techniques for deducing foliage density

and angle distribution from measurements of gap frac-

tion (or contact frequency) have been presented by
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many authors, including Warren Wilson (1959), Miller

(1963, 1967), Philip (1965), Ross (1981), Anderson

(1984a, 1984b), Lang (1986, 1987), Lang et al. (1985),

Perry et al. (1988), and Norman and Campbell (1989).

Derivation of Formulae for
Determining # of B Readings
The guideline presented in Chapter 4 Measurement

Guidelines for determining the number of B readings

comes from the following analysis:

M m t n E= ± ( ) 9-31

where M is the true mean of a population, m is the

mean of a sample of that population, t(n) is the value of

the t distribution (ignoring sign) for a 5% probability,

and E is the standard error of m. We rewrite equation

9-31 in terms of an acceptable uncertainty δ:

δ= 1 ±
M

m
9-32

Since standard error E is standard deviation D divided

by the square root of the number of samples n, we can

express δ as:

δ =
t n D

m n

( )
9-33

To solve equation 9-32 for sample size n, we find a func-

tional relationship for t(n) by fitting a curve to the form

t n c( ) = +
a bn

1

+
9-34

and find a= -0.11528, b= 0.060798, and c = 2.9817. Sub-

stituting equation 9-34 into 9-32 and solving for n yields

n =
B B bC

b

− + 2 − 4

2
9-35



9 Theory

9-13

where

( )B a bc= −
D

mδ

2 and ( )C ac= −(1 + )
D

mδ

2 .

As a practical matter, the term D/(mδ ) can be determ-
ined by a “trial measurement” with the LAI-2200 using

some number of B readings. These readings should be

a fair representation of the diversity of the foliage dens-

ity. Given LAI, SEL, and SMP , the D/ (mδ ) term can

be computed from

( )
=

D

mδ

SEL SMP

LAI δ

( )

( ) 9-36

Table 9-2. below, from equation 9-35, predicts the num-

ber of samples necessary for a 95% confidence that a

sampled mean is within some error δ of a population
mean.

Table 9-2.

D/(mδ) n D/(mδ) n D/(mδ) n

0.2 2 1.2 8 2.2 19

0.4 3 1.4 10 2.4 22

0.6 4 1.6 12 2.6 25

0.8 5 1.8 14 2.8 28

1.0 7 2.0 16 3.0 30

Table 4-1. (page 4-4) is in terms of SEL and LAI, rather

than D and m, and is based on a sample of 6 (SMP) with

δ=0.1.
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10 Appendices
Appendix A: Software Updates
and Other News
The FV2200 software application can notify you of soft-

ware updates and other LAI- 2200 related devel-

opments if the computer that is running the application

has Internet access. Each time it is launched, FV2200

checks to see if there are any notifications that it has

not already told you about, and if so, shows them to

you. You can view the latest notifications at any time

by clickingHelp > Latest LAI-2200 News. This noti-

fication summary has links that will take your web

browser to the appropriate locations.

You can also select Help > Check for Software

updates > Show Wand and Console Information to

view the latest versions of FV2200, console, and wand

software, and, if you choose, download them from the

FV2200 application.
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Appendix B: Updating the Firm-
ware
There are two firmware components in the LAI-2200 –

the console firmware and the wand firmware. Any

updates will be available for download from FV2200

Help > Check for Software updates > Show Wand

and Console Information. The following procedures

describe how to update the firmware.

Console Firmware Update

1. Acquire a console firmware file. It will have a name

similar to “lai01.img”. Downloaded using FV2200

Help > Check for Software updates > Show

Wand and Console Information. The file will be

saved to your "downloads" directory
2. Attach the LAI-2200 console to a computer using

the USB connection. After the LAI-2200 has been

recognized by the computer, copy the new firm-

ware file to the LAI-2200 mass storage device root

directory.
3. Next, “eject” the disk, then disconnect the LAI-

2200 from your computer. Power on the control

unit and navigate to Main Menu > Firmware >

Console > Upgrade. Select the new firmware file

and press OK . The new firmware will take several

minutes to install, and a “Complete OK” message

will be displayed when it is finished. Press the

“OK” when the firmware update is complete.
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Optical Sensor Firmware Update

1. Acquire an optical sensor firmware file from

FV2200 by clicking Help > Check for Software

updates > Show Wand and Console Inform-

ation and saving the file to your downloads folder..

It will have a name similar to “wand01.bin”. Sub-

sequent versions will have a larger number.
2. Copy the file to the Console memory as in step 2 in

the previous example.

Note that the wand firmware can only be updated through “port

X”. The firmware version can be checked through port X or Y,

but updates can only be delivered to wands connected to the X ter-

minal.

3. Disconnect the LAI-2200 from the computer. Con-

nect the wand to “port X”, turn on the console,

and navigate to Main Menu > Firmware > Con-

sole > Upgrade. Select the new file and press

“OK”. The update will take several seconds to com-

plete.
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Appendix C: Replacing the
Internal Lithium Battery
The following steps describe how to replace the

internal lithium battery. The battery should last up to 7

years. Always use a BR1225 watch battery (p/n 442-

08614).

1. Using a #1 Phillips screwdriver, loosen the four

screws that secure the top and bottom of the con-

trol unit. The four screws are located in the corners

of the back of the control unit, under the gray pro-

tective rubber. Nudge the rubber out of the way of

the screws.
2. Gently separate the two halves.
3. The battery is in a round coin-cell battery holder

(see below). Lift the silver tab slightly and slide the

battery out. It may be necessary to lift the battery

slightly with the blade of a standard screwdriver.
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4. Slide the new battery into the holder with the pos-

itive (+) terminal facing up.
5. Join the top and bottom halves of the control unit.

Be sure the rubber seal is seated properly.
6. Gently tighten the four screws that hold the two

halves of the case together. Be very careful not to

over tighten the screws, as they may strip the

plastic.
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Appendix D: Troubleshooting
Console will not power up:

This could be one of three things: low batteries, a

locked processor (try removing the batteries for a few

seconds), or a short in a wand (try disconnecting all

sensors).

Can’t match sensors:

Be sure both sensors see the same diffuse view. Also,

be sure that both wand match values are set to their

default values before performing a match. If the match

values are not set to their defaults there is a chance that

the match will fail. If you are still unable to match the

sensors after restoring the default values, reset the

match values to those given on the calibration sheet

with the sensor. Then perform the match again.

If the sensors see direct sunlight or artificial light, then

the match procedure is futile.

Instrument will not turn off:

The LAI-2200 will not power off if a data file is open or

if it is reading data from the internal memory. Wait a

few moments for the data transfer to finish and close

any open data files, then try again. If the control unit

continues to be unresponsive, press and hold the

power button for 5 seconds. Open data files may be

lost. If the LAI-2200 continues to be unresponsive,

remove the “AA” batteries for a moment. Replace the

batteries. Stored data will not be at risk, but open data

files may be lost.

Instrument (wand or console) locks up:

For both the wand and console, remove and re-install

the batteries.
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Wand not recognized or does not respond to light:

Disconnect then reconnect the wand. After a few

seconds, the control unit should begin displaying val-

ues associated with the wand.

LAI=0

Check the raw readings on the console or using

FV2200. Are there both A and B records in the file?

Do the relative magnitudes of the A and B records

seem correct? Check the number of samples used. If it

is 0, then the unit threw out all the A and B pairs

because of bad readings. Set the Transcomp settings to

APC and recompute the file.

Questionable MTA results:

This may indicate a problem, or be due to the method

used by the control unit to compute MTA. Check the

DISTS values. If they do not reflect the canopy being

measured (isolated canopy or large area), MTA and LAI

will be incorrect. Also, the method used by the control

unit has the drawback of losing resolution near the

extremes of 0° (horizontal leaves) and 90° (vertical

leaves). Refer to figure 8-2 for a plot of the polynomial

used. Note that slight changes in slope (the inde-

pendent variable) make a big difference at the extremes

of MTA. It is not uncommon in a canopy of relatively

horizontal foliage for the control unit to give MTA val-

ues from 0° to 20° or even 30° from one measurement

to the next. If more accurate MTA’s are needed, use

the FV2200 software to compute a mean tip angle with

the Constrained Least Squares technique.
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Appendix E: Specifications
LAI-2270 Control Unit

Sensor Inputs: 2 6- pin bulkhead connectors for

LAI-2250 Optical Sensors. 2 BNC bulkhead connectors

for LI-COR Light Sensors.

Memory: 128 MB of FAT16 memory.
Limits of FAT:

Number of files: 65536

8.3 file name convention (8 character name, 3 character

extension)

File Storage Capacity: ~70 bytes for each record; ~500

bytes for data file overhead.

Ex: 500 bytes/file + 70 bytes/record *100 records =

7,500 bytes; 128 MB/7,500 bytes =

17,030 files containing 1.7 million records.

Keypad: 22 button tactile response keypad. 10 key

numeric keypad with full alphabetic capabilities with 9

function/control keys.

Display: 128x64 graphics LCD display.

Communications:
USB (as mass storage device);

RS-485: Baud rate - 115,200, 8 data bits, no parity, 1 start,

1 stop;

RS-232: baud - 57600, and 115200, 8 data bits, no parity,

1 start, 1 stop.

Clock: Year, Month, Day, Hour, Minute, Second. Accur-

acy of ±3 minutes per month.

Power Requirements: 4 “AA” batteries (alkaline, NiMH,

or lithium).

Battery Life: 140 hours with 4 “AA” alkaline batteries, no

optical sensor attached. 80 hours with 4 “AA” alkaline bat-

teries, with one optical sensor attached.

Low Battery Warning: Display indicates when battery

power is <15%.

Size: 20.9 x 9.8 x 3.5 cm (8.2” x 3.9” x 1.4”).

Weight: 0.454 kg (1.0 lb) with batteries.
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LAI-2250 Optical Sensor

Sensor Inputs: 1 6-pin bulkhead connector for control

unit interface.

Memory: 1 MB flash memory for record storage; 1KB

EEPROM for calibration and configuration storage.

Keypad: 2 button, tactile response keypad.
Indicators:3 sunlight readable LEDs to indicate: power

status, logging status, above/below status.

Clock: Year, Month, Day, Hour, Minute, Second. ± 3

minutes per month.

Power Requirements: 2 “AA” batteries (alkaline, NiMH,

lithium).

Battery Life: 180 hours of typical operation (with 2

alkaline batteries).

Low Battery Warning: LED indication when <15% of

battery life remains.

Optics: 1.00° maximum decentering error as measured

from center of mass of ring 0.50° maximum magnification

error as measured from the center of mass of ring 4.

Wavelength Range: ≈320-490 nm
Radiation Rejection:
>99% from 490-650 nm.

>99.9% above 650 nm.

Nominal Angular Coverage:
Ring1: 0.0-12.3°

Ring 2: 16.7-28.6°

Ring 3: 32.4-43.4°

Ring 4: 47.3-58.1°

Ring 5: 62.3-74.1°

Lens Coating: MgF2 for improved transmission at

oblique angles (external and internal lenses).

View Caps: Provide azimuthal masking of view into quad-

rants of 0°, 10°, 45°, 90°, 180°, and 270°.

Size: 63.8 L x 2.9 W x 2.9 D cm (25.1” x 1.125” x

1.125”) (Endcap: 4.4 W x 5.1 D cm; 1.75” x 2.0”).

Weight: 0.845 kg (1.86 lbs) with batteries.
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LAI-2200 General

Environmental Conditions:

Operating Temperature Range: -20 to 50° C.
Humidity Range: 0 to 95% RH, non-condensing con-

ditions.

Storage Temperature Range: -40 to 65° C.
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Appendix F: Part Numbers
The following is a partial list of parts available from      

LI-COR Biosciences.

Contact sales (envsales@licor.com), call 1-800-447-3576

(US & Canada), 1-402-467-3576 (international), or order

the parts from the LI-COR Biosciences eCommerce

website (go to http://www.licor.com/env/ and click

on “Order”).

Description Part #

LAI-2270 Control Unit LAI-2270

LAI-2250 Plant Canopy Sensor LAI-2250

Optical Sensor Cable 9922-127

View Restrictor Cap Set 9920-005

Lens Cap 6520-020

View Restricting Cap 90° Opening 6520-021

View Restricting Cap 180° Opening 6520-022

View Restricting Cap 45° Opening 6520-023

View Restricting Cap 270° Opening 6520-029

View Restricting Cap 10° Opening 6520-030

9 Pin Connector Dust Cap 9914-008

3 V Lithium Battery BR1225 442-08614

Optical Sensor Battery Compartment Cap 345-10735

Storage Case 9922-125
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Appendix G: Differences Between
the LAI-2000 and the LAI-2200
1.0 Operational

1.1 The LAI-2200 uses menus instead of Fct codes.

Access the menu by pressing the Menu key. The full

structure is given in Chapter 8 Instrument Software

Reference. Changes are shown below, along with the

equivalent Fct codes that the LAI-2000 used.
Main Menu
Wand Setup
<user picks wand>
Set Name
Clock
Cal Values "Fct 01 XCal or Fct 02 YCal"
Match Values "Fct 03 Vectors"
Auto Log "Fct 11 Set Op Mode " for remote

above logging.
Log Setup
Transcomp "Fct 16 Bad Reading", plus other

new options.
Prompts "Fct 12 Set Prompts"
Angles "Fct 07 Set Angles"
Distances "Fct 06 Set Dists"
Masks
Control Sequence "Fct 11 Set Op Mode"
PAR Sensors "Fct 08 1,2 Channels"
Data

Wand Data
Download
Purge

Console Data
<user picks file>
View "Fct 27 View"
View Header
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View Ang/Dst
View Cntct#/StdDev
View Ang/Gap Frac
View Observations

Edit "Fct 25 Edit"
Edit Angles
Edit Mask
Edit Distances
Edit Transcomp
Import Observations
Strip Observations

Recompute "Fct 26 Recompute"
Delete
Rename
Console Setup
Set Time "Fct 05 Set Clock"
Upgrade Firmware
Auto Off Timer
Beeper

1.2 Optical Sensors (Wands) are Smart.
1.2.1. The console can detect when one is attached,

and which port it is attached to.
1.2.2. The wands carry their own identity and cal-

ibration information with them.
1.2.3. The wands can log data without being attached to

a console. Here's the thing to remember: If a wand is

attached to the console, and a log file is open, press-

ing the LOG key on the console or on the wand will

add a record to the file in the console. Otherwise,

pressing LOG will add a record to the memory of

the wand. Also, automatic logging can be set up for a

wand (define start time, stop time, and frequency).

Any autologged data always goes the wand memory.

To get records out of a wand, attach it to a console,

and do Menu > Data > Wand > Download. You
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can put the data into a new file, or append it to an

existing file.
1.3 Less Dependence on Operating Mode. The LAI-

2000 had a list of operating modes to choose from (1

Sensor X, 1 Sensor Y, etc.). These have essentially

gone away. To illustrate this, we show below how to

do the most common of the former modes using the

LAI-2200:
A) 1 Sensor X or Y:
Power on.
Attach a wand.
Press Start/Stop. Name the file.
Use the A/B button on the wand to select if the

next reading is A or B.
Log readings.
Press Start/Stop to close the file.

If you want to do a predetermined sequence (↑↓↓↓ ,
etc.), you can set that up viaMenu > Log Setup >

Control Sequence.

B) Remote Below, and Remote Above:

Power ON
Attach Both Sensors.
Match one to the other (Menu > Wand Setup >

(pick one to adjust) > Match Values)
Setup autolog. (Menu > Wand Setup > (pick the

A wand) > Auto Log)
Detach and deploy the A wand.
Collect B file(s) with the console and remaining

wand.
Retrieve the A data. Reattach the A wand, and do

Menu > Data > Wand > Download, and name a

new file.
Merge the A and B readings. Do Menu > Data >

Console > (pick a B file) > Edit > Import



10 Appendices

10-15

Observations , and select the A file. Repeat for

remaining B files.

2.0 Computational
2.1 Weighting Factors. Both instruments compute LAI

by applying weighting factors to the contact values

computed for each ring (Equation 9-14-, page 9-7).

The LAI-2000 assigned ring data to the entire inter-

val between 0 and π/2, while the LAI-2200 only uses
the discrete bands actually viewed by the rings. Refer

to Table 6-1. Ring widths and weighting factors. ,

page 6-36 for LAI-2200 weighting factors.

2.2 Ignoring rings. The LAI- 2200 allows rings to be

ignored in the computation of LAI. To set this for

new data files: Menu > Log Setup > Masks . To

change this on an existing data fileMenu > Data >

Console > (pick a file) > Edit > Edit Mask

2.3 ACF. The LAI-2200 computes a new value, Appar-

ent Clumping Factor (ACF), which is a value 1 (no

clumping) or less (clumping). The LAI-2200 reports

an ACF value for each ring (the log of the average

transmittance divided by the average of the logs of

the transmittances), and a weighted average for all

the rings. This is discussed further on page 9-7.
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Appendix I: Warranty
For the most current warranty information, see the

Standard Terms and Conditions of Sale at

http://www.licor.com/corp/terms.jsp.

Each LI-COR, Inc. instrument is warranted by

LI-COR, Inc. to be free from defects in material and

workmanship; however, LI-COR, Inc.'s sole obligation

under this warranty shall be to repair or replace any part

of the instrument, which LI-COR, Inc.'s examination

discloses to have been defective in material or work-

manship without charge and only under the following

conditions, which are:

1. The defects are called to the attention of LI-COR,

Inc. in Lincoln, Nebraska, in writing within one year

after the shipping date of the instrument.

2. The instrument has not been maintained, repaired, or

altered by anyone who was not approved by LI-COR,

Inc.

3. The instrument was used in the normal, proper, and

ordinary manner and has not been abused, altered, mis-

used, neglected, involved in an accident or damaged by

act of God or other casualty.

4. The purchaser, whether it is a DISTRIBUTOR or dir-

ect customer of LI-COR or a DISTRIBUTOR'S cus-

tomer, packs and ships or delivers the instrument to

LI-COR, Inc. at LI-COR Inc.'s factory in Lincoln, Neb-

raska, U.S.A. within 30 days after LI-COR, Inc. has

received written notice of the defect. Unless other

arrangements have been made in writing, transportation

to LI-COR, Inc. (by air unless otherwise authorized by

LI-COR, Inc.) is at customer expense.

http://www.licor.com/corp/terms.jsp
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5. No-charge repair parts may be sent at LI-COR, Inc.'s

sole discretion to the purchaser for installation by pur-

chaser.

6. LI-COR, Inc.'s liability is limited to repair or replace

any part of the instrument without charge if LI-COR,

Inc.'s examination disclosed that part to have been

defective in material or workmanship.

There are no warranties, express or implied, including

but not limited to any implied warranty of mer-

chantability or fitness for a particular purpose on under-

water cables or on expendables such as batteries,

lamps, thermocouples and calibrations.

Other than the obligation of LI-COR, Inc. expressly set

forth herein, LI-COR, Inc. disclaims all warranties of

merchantability or fitness for a particular purpose. The

foregoing constitutes LI-COR, Inc.'s sole obligation

and liability with respect to damages resulting from the

use or performance of the instrument and in no event

shall LI-COR, Inc. or its representatives be liable for

damages beyond the price paid for the instrument, or

for direct, incidental or consequential damages.

The laws of some locations may not allow the exclu-

sion or limitation on implied warranties or on incidental

or consequential damages, so the limitations herein

may not apply directly. This warranty gives you specific

legal rights, and you may already have other rights,

which vary from location to location. All warranties that

apply, whether included by this contract or by law, are

limited to the time period of this warranty which is a

twelve-month period commencing from the date the

instrument is shipped to a user who is a customer or

eighteen months from the date of shipment to
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LI-COR, Inc.'s authorized distributor, whichever is

earlier.

This warranty supersedes all warranties for products

purchased prior to June 1, 1984, unless this warranty is

later superseded.

DISTRIBUTOR or the DISTRIBUTOR'S customers

may ship the instruments directly to LI-COR if they are

unable to repair the instrument themselves even

though the DISTRIBUTOR has been approved for

making such repairs and has agreed with the customer

to make such repairs as covered by this limited war-

ranty.

Further information concerning this warranty may be

obtained by writing or telephoning warranty manager at

LI-COR, Inc.
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